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Preface
Describes the purpose of these tutorials, the intended audience, and the 
typographic conventions.

About this Tutorial ix

Audience x

Conventions x

Related Documentation xi

Customer Support Services xiii

About this Tutorial
This tutorial teaches you how to create, run, and analyze models in e-SCOR. First, 
it provides an introduction to SCOR modeling and how it relates to e-SCOR. 
Next, it teaches you how to create and analyze three models of varying 
complexity:

• The simplest e-SCOR model, which consists of a Base Manufacturer role that 
manufactures and distributes a product family and a Consumer role that 
sources the product family. 

• The ACME model, which is a more complex model that manufactures 
computers from components. The Manufacturer role sources cases directly 
from a Base Manufacturer role and electronics through a Distributor role. 

• The VMI model presents a case study of a real-world business problem 
involving a central pharmaceutical distributor and three distribution sites. 
You create, run, and analyze the model to determine optimal inventory 
replenishment levels to ensure that each downstream customer always 
receives its shipments on time.
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If you are just starting out with e-SCOR, we recommend that you read this 
tutorial sequentially and perform each exercise in order. This table summarizes 
how long each part of the tutorial should take to read and perform the exercises:

If you have some familiarity with e-SCOR, you can go to specific topics in this 
tutorial. Topics that appear later in this tutorial provide references to earlier topics 
that explain specific steps in more detail, where relevant.

In addition, most tutorial topics provide references to related topics in the e-SCOR 
User? Guide. 

Audience
This tutorial is for new e-SCOR users who want step-by-step instructions that 
teach you how to build, run, and analyze e-SCOR models. It is also a good place 
to start to see examples of the kinds of models you can build and the kinds of 
problems you can solve, using e-SCOR.

Users should be familiar with supply-chain modeling and have some familiarity 
with SCOR. 

If you are not familiar with SCOR, visit www.supply-chain.org.

Conventions
This tutorial uses the following typographic conventions: 

Model Time Estimate

Simplest e-SCOR Model 1 hour

ACME Model 4 hours

VMI Model 4 hours

Example Description 

true Parameter and metric values

role Glossary terms

Order Fulfillment Lead Time SCOR metrics

c:\Program Files\Gensym\
g2-8.3r0\escor\
kbs\e-scor.kb

Pathnames and filenames
x



Related Documentation
Related Documentation
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Customer Support Services
• G2-HLA Bridge User? Guide

• G2 WebLink User? Guide

G2 JavaLink

• G2 JavaLink User? Guide

• G2 DownloadInterfaces User? Guide

• G2 Bean Builder User? Guide

G2 Diagnostic Assistant

• GDA User? Guide 

• GDA Reference Manual
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Customer Support Services
You can obtain help with this or any Gensym product from Gensym Customer 
Support. Help is available online, by telephone, by fax, and by email.

To obtain customer support online:

 Access G2 HelpLink at www.gensym-support.com. 

You will be asked to log in to an existing account or create a new account if 
necessary. G2 HelpLink allows you to:

• Register your question with Customer Support by creating an Issue.

• Query, link to, and review existing issues.

• Share issues with other users in your group. 

• Query for Bugs, Suggestions, and Resolutions.

To obtain customer support by telephone, fax, or email:

 Use the following numbers and addresses: 

Americas Europe, Middle-East, Africa (EMEA)

Phone (781) 265-7301 +31-71-5682622

Fax (781) 265-7255 +31-71-5682621

Email service@gensym.com service-ema@gensym.com
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e-SCOR Methodology
Describes the e-SCOR methodology for SCOR modeling.

Introduction 2

Deciding What You Want to Model 3

Mapping SCOR Processes to e-SCOR Roles 4

Learning How to Build Models in e-SCOR 7

Using the Tutorial Models 8
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Introduction
e-SCOR allows you to quickly build SCOR-based, supply-chain simulation 
models by connecting supply-chain nodes, called “roles,” Manufacturers, 
Distributors, and Consumers, entering configuration data, and running scenarios. 
In e-SCOR, supply-chain roles correspond to logical combinations of SCOR model 
process types. For example, a e-SCOR Distributor role comprises SCOR Source, 
Make, and Deliver process types. These combinations are useful aggregations of 
SCOR process types and correspond to SCOR “Level 0.”

As described in the Supply Chain Council SCOR Version 7.0 Overview, SCOR is a 
process “reference” model that differs from classic process “decomposition” 
models. In a process decomposition model, a process is described in layers with 
higher level process layers having detail layers that describe sub-processes 
composing the higher level process. SCOR uses this idea in formulation of the 
model, but also allows for multiple “levels” at the same process “layer.” 
Specifically, in SCOR, Levels 1 and 2 are different configurations at the same 
process layer.

The Supply Chain Council SCOR Version 7.0 Overview booklet (see 
http://www.supply-chain.org/site/scor7booklet.jsp) describes a 
7-step process for creating a SCOR model. This chapter shows how you can use 
e-SCOR to create a standard SCOR model, such as one you might create in the 
SCOR course.

The following figure is a typical map of a supply chain that you might already 
have or that you could develop quickly. The map shows material flow along with 
the location of suppliers, distribution centers or warehouses, manufacturing sites, 
and customers. By convention, customers are always located to the right on the 
map and suppliers of raw materials are located to the left on the map.
2



Deciding What You Want to Model
The following sections describe how you can quickly convert this map into a 
e-SCOR model and begin conducting analyses.

Deciding What You Want to Model
Before you begin creating your map, you have to decide on the business entities 
you want to model, their geographic locations, and the relevant product set. In 
thinking about the product set, consider grouping products into categories of 
families or types such that the relevant products are represented. By “relevant,” 
we mean products that behave similarly in the supply chain or that are directly 
involved in the issue you want to examine.

For example, you might have hundreds of products but one or two are 
representative of the issue you want to address. Another example might be a 
situation where you have 100,000 SKUs in your supply chain, but you are only 
concerned with 10 product types or product families. Be parsimonious in your 
selection of a product set so you focus your analysis on what matters most to you. 
3



e-SCOR is most valuable to organizations that want to examine supply chain 
resilience. Resilience relates to supply chain robustness and agility issues such as:

• The responsiveness of your supply chain. 

What would happen if the demand for a product increased or decreased by a 
certain percentage? Would I have sufficient manufacturing capacity? Would I 
be able to respond fast enough?

• The flexibility of your supply chain.

What would happen if my distribution network was disrupted? Would I be 
able to meet customer service requirements by shifting to other sources? 
Would manufacturing capacity be available and could they gear-up for 
production fast enough?

• The impact of fast changes or variability in product, processing, or distribution.

How do I deal with changing product life cycles? What is the impact on my 
supply chain of moving from one product to the next? What if product 
characteristics change that impact production or other suppliers? What if my 
supplier(s) are inconsistent in their delivery? What if the production lines 
have quality or yield problems? What if the transit time from role to role is 
inconsistent?

Mapping SCOR Processes to e-SCOR Roles
Once you have identified the features of your supply chain that you want to 
examine, you can map the SCOR processes to the e-SCOR roles. 

In developing a map of your supply chain, you will have explicitly identified the 
sites, materials and transit lanes, and organizational entities involved in your 
supply chain. With this information, you can decide where to place the Source, 
Make, Deliver, and Plan process types on your map. Initially, you do not need to 
worry about whether each site on your map is a Stocked, Make-to-Order or 
Engineer-to-Order node. For simplicity, assume they are all Stocked types.

e-SCOR provides a convenient way to group SCOR process types, as follows:

• A suppler role, which we call a Base Manufacturer, occupies the left-most 
position in a supply chain and comprises Make and Deliver types. A supplier 
does not need a Source process type because we assume the sourcing 
processes further to the left are not relevant.

• A manufacturer role comprises Source, Make, Deliver, and Plan types.

• A distributor role comprises Source, Deliver, and Plan types. Distributors may 
assemble products into “kits,” but they do not have a Make process type.

• A customer role comprises only a Source type. Customers occupy the right-
most position in a supply chain.
4



Mapping SCOR Processes to e-SCOR Roles
With this information, you can create a SCOR process map that looks like this:

Note how the groups of SCOR process types combine into e-SCOR roles:

• The European RM Supplier and Key Other RM Suppliers are Base 
Manufacturer roles.

• The ALPHA node is a Manufacturer role.

• The ALPHA Regional Warehouses is a Distributor role.

• The American Distributors and Distributors are Customer roles because they 
exert a demand on the upstream supply chain.
5



With this information, you can create a map that translates directly into a e-SCOR 
model. The e-SCOR map corresponding to the supply chain in the figure above 
looks like this:

To simplify the supply chain, this map assumes that each role has its own 
Plan Source, Plan Make, and Plan Deliver capabilities. This diagram also shows 
the finished good produced or distributed by each role: 

• The European RM Supplier produces Computer Cases.

• The Key Other RM Suppliers produce Electronics.

• The Alpha Regional Warehouses distribute Computers.

• The customer (Distributors) buys Computers.

With this information, you can now build the ACME model in e-SCOR and 
experiment with different scenarios, which you will do later in this tutorial.
6



Learning How to Build Models in e-SCOR
Learning How to Build Models in e-SCOR
First, this tutorial describes the mechanics of how to create and configure a simple 
supply-chain model so you become familiar with the modeling environment. It 
then explains in detail how to create and configure the ACME model. Finally, it 
describes how to build a more complex model called the VMI model. 

This tutorial teaches you how to build these models:

• The simplest e-SCOR model, which consists of a Base Manufacturer role that 
manufactures and distributes a product family, and a Consumer role that 
sources the product family. The simplest model teaches you how to:

– Configure the model environment, which consists of a model and an 
associated Scenario.

– Configure Level 1 roles, which involves creating the supply-chain model, 
configuring role parameters, assigning products to roles, and configuring 
the potential suppliers. 

– Run the simulation and view role metrics and Level 2 metrics through the 
Metrics toolbars.

– Configure Level 2 SCOR, which involves viewing role details, configuring 
category parameters, and configuring product composite parameters.

– View Level 2 metrics for categories and product composite through 
the dialogs.

– Create output reports of key performance metrics, both within e-SCOR 
and in CSV files.

• The ACME model, which manufactures computers from components. The 
Manufacturer role sources cases directly from a Base Manufacturer role and 
electronics through a Distributor role. The ACME model teaches you how to:

– Configure Level 1 roles to source, make, and deliver finished products and 
components that are part of a product structure.

– Configure Level 2 SCOR parameters through input reports. 

– Run the simulation to determine the performance of the model under two 
scenarios: normal demand and increased demand.
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• The VMI model, which presents a case study of a real-world business 
problem involving a central pharmaceutical distributor and three distribution 
sites. You create, run, and analyze the model to determine optimal inventory 
replenishment levels to ensure that each downstream customer always 
receive its shipments on time. The VMI model teaches how to:

– Implement the central distributor model according to the case study by 
mapping real-world inputs and outputs to e-SCOR parameters and 
metrics, creating and configuring the supply-chain model, and 
configuring Level 2 SCOR parameters through input reports.

– Run the central distributor model simulation by estimating replenishment 
levels, creating time-series reports of inventory levels and days of supply, 
and creating summary tables and charts for configuring key parameters 
and viewing key metrics.

– Optimize the central distributor model by using a worst-case scenario, 
fine-tuning the results to minimize inventory carrying costs, and 
analyzing the impact of implementing a vendor-managed inventory 
control system.

Using the Tutorial Models
At various points in this tutorial, you have the option of loading finished models 
and summary reports that are solutions to the individual tutorials. If you do not 
have time to work through the tutorials yourself, you can use these models and 
reports instead.

To open a tutorial model in e-SCOR:

 Choose File > Open, navigate to the escor\examples directory of your 
e-SCOR installation, and choose the tutorial model to open.

The following list summarizes the models and reports you can load and the 
chapters that describe each:

• escor-tutorial-simplest
Tutorial-Simplest-Model-Summary-Reports.xls

Configuring the Model Environment
Configuring the Simplest Model
Running the Simulation: Simplest Model
Configuring Level 2 SCOR: Simplest Model
Viewing Level 2 Metrics: Simplest Model
Creating Output Reports: Simplest Model
8



Using the Tutorial Models
• escor-tutorial-acme
Tutorial-ACME-Summary-Reports.xls

Configuring Level 1 Roles: ACME Model
Configuring Level 2 SCOR: ACME Model
Running the Simulation: ACME Model

• escor-tutorial-vmi
Tutorial-VMI-Summary-Reports.xls

Case Study: Central Distributor Model
Running the Simulation: Central Distributor Model
Optimizing the Central Distributor Model
9
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2

Configuring the
Model Environment
Teaches you how to configure the environment in which you create a model.

Introduction 12

Running e-SCOR 12

Creating a New Project 14

Creating a Model 14

Creating a Scenario 14

Saving a Model 16

Starting e-SCOR with a Particular Model Open 16

Summary: Configuring the Model Environment 18
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Introduction
To configure the model environment, you:

• Run e-SCOR.

• Create a new project.

• Create a model.

• Create a scenario, which is the discrete event simulation engine for controlling 
the simulation.

• Save the model.

• Start e-SCOR with your model open by configuring the server to load your 
model.

Many e-SCOR objects have detail, which is a workspace associated with an object 
on which you place and view other objects. You create e-SCOR models on the 
detail of a Model object, also known as the model detail.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-simplest.kb, which shows the 
finished model. Follow along in the existing model as you read through the 
exercises.

Running e-SCOR
e-SCOR is a client/server application, where the server runs as a hidden process. 
To run e-SCOR, first you must start the server, then you can start the client. The 
server and client can run on the same computer or on different computers. 

e-SCOR is distributed as a set of modularized KB files, with a top-level module 
that automatically requires all the e-SCOR modules. The top-level module is 
called e-scor.

When you first start e-SCOR, it is running in Modeler mode, which means that all 
e-SCOR functionality required for creating and running a model is available to 
you. To access additional functionality required to customize e-SCOR, you must 
switch to Developer mode. For information about switching user modes, see the 
e-SCOR User? Guide.
12



Running e-SCOR
To run e-SCOR:

1 Choose Start > Programs > Gensym G2 8.3r0 > G2 e-SCOR > 
Start G2 e-SCOR Server.

This launches the server on the local machine.

2 Choose Start > Programs > Gensym G2 8.3r0 > Telewindows Next Generation. 

This launches the Telewindows client on the local machine and connects to the 
server.

When e-SCOR has been loaded, you will see this window:
13



Creating a New Project
To create a new project:

1 Choose File > New.

2 Enter a unique name as the name of the project, for example, my-tutorials.

The project name cannot contain spaces.

3 Ensure that e-SCOR is chosen as the selected library and add any other 
additional libraries that you might need.

e-SCOR creates a new, blank project with the name you enter. 

Creating a Model
Your project can contain one or more models, such as an “As Is” model and a 
“To Be” model. You create and manage supply-chain models through the Project 
menu.

To create a model:

1 Choose Project > System Models > Supply Chain Processes > Manage to 
display a dialog for managing supply-chain process models.

2 Click the New button ( ) to display the properties dialog for creating a new 
model.

3 Edit the Label to be Simplest Model.

The manage dialog now contains your model. 

4 With your new model selected, click the Model button ( ) to show the 
model detail.

You create your supply-chain model on the model detail. 

Creating a Scenario
The control center for running a simulation is a Scenario object. You control the 
scenario from the Simulation menu or toolbar. 

A scenario displays the:

• Current simulation time.

• Simulation mode, which is jump by default.

• Simulation status, which is initially inactive. 
14



Creating a Scenario
Normally, you run the simulation in jump mode, which advances the simulation 
clock with each new event without pausing between discrete steps. You can also 
run the simulation in step mode, which advances the simulation clock with each 
new event, then pauses the simulation, or synch mode, which synchronizes the 
simulation clock to real time, using a scale factor. 

Tip Normally, you run simulations in jump mode. You use step mode when 
debugging models at Level 3 and Level 4. You use synchronized mode to 
simulate actual delays in the model; however, you would probably do this only 
when debugging models as well. 

When you run a simulation, the status changes depending on whether it is active, 
running, paused, or resetting.

You can configure various aspects of the Scenario object, including the simulation 
mode, start time, duration, and animation. By default, the simulation start time is 
January 1, 2006, it is configured to run for a maximum of 17 years, and animation 
is on. 

Tip We recommend disabling animation when working with these tutorials.

To create a scenario:

1 Choose View > Toolbox - e-SCOR to display the e-SCOR toolbox, then click 
the Tools button to display the Tools palette.

Tip Hover the mouse over the button to display tooltip. 

2 Select a Scenario, then click the model detail to place the object on the detail.

3 Choose Properties on the scenario, click the Options tab, and disable the 
Enable Animation option.

You can shrink wrap the borders of the detail workspace, which adjusts the 
window size to just fit the workspace. You can drag objects beyond the 
workspace borders to expand the workspace size. And you can adjust the 
window size to be smaller than the workspace, which displays scroll bars on 
the window.

4 Experiment with dragging the Scenario object on the workspace to adjust the 
borders, adjusting the window size, and shrink wrapping the workspace to 
just fit the object. 

To shrink wrap the workspace, choose Shrink Wrap from the Layout menu or 
from the popup menu for the workspace, or click the equivalent button on the 
Layout toolbar ( ).
15



The model detail should look something like this:

See Also Controlling the Simulation in the e-SCOR User? Guide.

Configuring the Scenario in the e-SCOR User? Guide.

Saving a Model
You save models to a .kb file whose name corresponds with your project name. 

You save models to a .kb file that corresponds to the project name, in this case, 
my-tutorials.kb. The project is located in the projects directory of your 
e-SCOR installation directory.

To save a model:

 Choose File > Save.

Starting e-SCOR with a Particular Model Open
You can open a different model by choosing Open from the File menu. You can 
also create a shortcut that starts e-SCOR with a particular model open.

e-SCOR is a client-server application. You can configure the e-SCOR server to 
load your model on startup by creating a shortcut to the batch file that starts the 
server and modifying its command arguments. The batch file that starts the 
e-SCOR server is:

"C:\Program Files\Gensym\g2-8.3r0\g2\StartServer.bat" 
-kb ..\escor\kbs\e-scor.kb -nowindow
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Starting e-SCOR with a Particular Model Open
In the shortcut, the first argument specifies the KB to load, which specifies a 
relative pathname with the .kb extension. For example:

"C:\Program Files\Gensym\g2-8.3r0\g2\StartServer.bat" 
-kb ..\projects\my-tutorials.kb -nowindow

If you are running the e-SCOR server and the e-SCOR client on the same local 
machine, the e-SCOR client can automatically connect to the server. It does this by 
connecting to the machine named localhost at port 1111. 

If you are running the e-SCOR server and client on different machines, you can 
connect to a particular server from the client by choosing Connect to Server from 
the Go menu. You can also create a shortcut to the e-SCOR client batch file and 
configure the host and port to which to connect. For details, see the e-SCOR User? 
Guide.

To start e-SCOR with a particular model open:

1 Choose Create Shortcut on the Start G2 e-SCOR Server shortcut in the Start 
menu, then drag it to your desktop.

2 Choose Properties on the shortcut and click the Shortcut tab.

3 Edit the Target to include the .kb file to load, as specified above.

4 Choose Tools > User Mode > Developer or choose Developer mode on the 
toolbar.

Note You cannot exit the e-SCOR server in Modeler mode; you must be in 
Developer mode. 

Alternatively, you can choose File > Close to exit the client, then mouse right 
on the G2 server icon in the system tray and choose Shut Down G2.

5 Choose File > Exit to exit e-SCOR and click Yes to shutdown the server as 
well.

Now, you will start the e-SCOR server and client with your model already open.

To start e-SCOR with your model open:

1 Double-click the shortcut to start the e-SCOR server with your model open.

2 Start the Telewindows Next Generation client.

e-SCOR should now be running with your model open.
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Summary: Configuring the Model Environment
To configure the e-SCOR model environment, you:

• Created a project.

• Created a model.

• Created a scenario.

• Saved the model.

• Started e-SCOR with your model open.

You should now know how to configure the model environment for the simplest 
model. 

Next, you will configure Level 1 roles to create a supply-chain model.
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Introduction
To develop an e-SCOR model, you create and configure process roles, which 
comprise the four Level 2 SCOR management processes — Plan, Source, Make, 
and Deliver. These roles correspond to the four basic functions in a supply chain 
and are implicit in the description of Level 1 SCOR. The four process roles are:

• Base Manufacturer role — Represents the node that is the ultimate supplier 
of raw materials to downstream buyers.

• Distributor role — Represents the node that sources products from upstream 
suppliers and delivers those products to downstream buyers in the form of 
components, complete products, or product assemblies, also known as “kits.”

• Manufacturer role — Represents the node that sources components from 
upstream suppliers, makes finished products, and delivers those finished 
products to downstream buyers.

• Consumer role — Represents the node that asserts a demand on the supply 
chain by placing orders for products from upstream suppliers.

The simplest possible e-SCOR model consists of a Base Manufacturer role, which 
delivers a single product family, and a Consumer role, which sources the product 
family. 

Note All e-SCOR supply-chain models must include a Base Manufacturer role and a 
Consumer role. 

To create and configure Level 1 roles for the simplest e-SCOR model, you: 

• Create a product specification to describe the product family that each role in 
the supply chain sources, makes, and/or delivers.

• Create the supply-chain model by creating and optionally connecting roles.

• Configure role parameters, including its name and financial parameters.

• Assign products to roles to determine the products a role sources and/or 
delivers.

• Configuring potential suppliers for source products.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-simplest.kb, which shows the 
finished model. Follow along in the existing model as you read through the 
exercises.

See Also e-SCOR Implementation of Level 1 Roles in the e-SCOR User? Guide.
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Configuring the Product Specification: Simplest Model
Configuring the Product Specification: 
Simplest Model

A supply chain can process one or more products. You model this by creating a 
product hierarchy, or bill of materials, which consists of product specifications 
for each product that the supply chain sources, makes, and/or delivers. 

In the simplest model, the product hierarchy consists of a single product 
specification, which represents an entire product family.

In a more realistic model, the product hierarchy consists of finished products, 
which consist of one or more components, where the components themselves can 
consist of other components. You will learn how to create a product hierarchy 
with components later in this tutorial.

In general, you create the product hierarchy on the detail of a Product Structure 
Organizer.

Tip If the product hierarchy consists of a single product specification, you can place 
the product specification directly on the model detail, rather than on the detail of 
a Product Structure Organizer. However, in this tutorial, you will place the 
product specification in an organizer.

To create a product specification for the simplest model:

1 If your project is not already open, choose File > Open and choose your 
project.

2 Choose Project > System Models > Supply Chain Processes > Simplest Model 
to display your model.

3 Display the e-SCOR toolbox, click the Products button, select a Product 
Structure Organizer, also called a Bill of Materials (BOM), and place it on the 
model detail.

4 Choose Show Detail on the product structure to display its detail.

You place the product specification on this detail.

Tip You can also show the detail of any object that has detail by using 
Ctrl + right-click.

5 Choose a Product Specification from the Products palette of the e-SCOR 
toolbox and place it on the Product Structure Organizer detail.

6 Display the properties dialog for the product specification.

To display the properties dialog for any e-SCOR object, you have a number of 
options: 
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• Right-click the object and choose Properties from the object’s popup 
menu.

• Double-click the object.

• Left-click the object to select it and press the F4 key.

• Select the object and choose Properties from the Edit menu or click the 
equivalent toolbar button ( ).

To accept the properties dialog, click OK or Apply.

7 Configure the Product Name to be Product Family and accept the 
properties dialog.

The label on the Product Specification shows the name you entered.

Note From now on, this tutorial does not explicitly state how to display the 
properties dialog for an object, nor does it explicitly state that you should 
accept the properties dialog. 

8 Shrink wrap the detail.

The Product Structure Organizer and its detail should look like this:

See Also Products in the e-SCOR User? Guide.

Creating the Product Hierarchy in the e-SCOR User? Guide.

Product Specification

Product Structure Organizer
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Creating a Supply-Chain Model: Simplest Model
Creating a Supply-Chain Model: Simplest 
Model

To create a supply-chain model, you create roles from the e-SCOR toolbox and 
place them in the order in which the processes occur in the supply chain, from left 
to right. A Base Manufacturer must be the first role in the supply chain on the left, 
and a Consumer must be the last role in the supply chain on the right. Distributor 
roles can appear downstream of Base Manufacturer roles, and Manufacturer roles 
can appear downstream or upstream of Distributor roles.

The simplest model consists of a single Base Manufacturer role and a single 
Consumer role. When you create the supply chain and run the simulation for the 
simplest model, the following objects flow around the model:

• Orders flow upstream from the Consumer role to the Base Manufacturer role.

• Product shipments and invoices flow downstream from the Base 
Manufacturer role to the Consumer role.

• Payments flow upstream from the Consumer role to the Base Manufacturer 
role. 

The model is automatically configured to process these and other required 
objects, such as purchase requests, purchase responses, and purchase awards.

To provide a visual indication of how roles are related in a supply chain, you can 
optionally create connections between roles. When physically connecting roles in 
the simplest model, you create an output stub on the downstream side of a Base 
Manufacturer role, which you connect to the upstream side of a Consumer role to 
create an input path. Manufacturer and Distributor roles have input stubs on the 
upstream side of the role and output stubs on the downstream side of the role.

To create the simplest supply-chain model:

1 Display the e-SCOR toolbox, click the Roles button, select a Base 
Manufacturer role, and place it on the left side of the model detail.

2 Select a Consumer role from the toolbox and place it to the right of the Base 
Manufacturer role.

e-SCOR creates unique labels for each role, which you can edit.

3 Select both roles and choose Layout > Align or Distribute > Align Top or click 
the equivalent toolbar button.

4 Shrink wrap the workspace.
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The model should look something like this:

See Also Creating the Supply-Chain Model in the e-SCOR User? Guide.

Configuring Role Parameters: Simplest Model
Each role defines a set of basic parameters that you can configure, such as the role 
label, which you can use to indicate the type of product a role sources or delivers. 

Note You must configure a unique Role Label for each role in the model. 

You can configure the highlight color of the role to visually distinguish different 
types of roles, and the longitude and latitude of the physical location of the role 
on a map. 

Each role also defines these financial parameters:

• Financial Period — Used for computing financial, cost, and asset metrics for 
the role. The default value is 4 weeks and 2 days (30 days).

• Financial Payment Terms — For supplier roles, determines the amount of 
time the downstream buyer has to make payments for goods received. A 
Consumer role ignores its Financial Payment Terms, because it is not a 
supplier. 

Thus, the supplier role determines the payment terms in the supply chain.
24



Assigning Products to Roles: Simplest Model
To configure basic role parameters for the simplest model:

1 Display the properties dialog for each role, in turn. 

For details, see Configuring the Product Specification: Simplest Model.

2 On the Role tab, configure this parameter for each role:

3 Adjust the location of the label relative to the role, as needed.

4 In the properties dialog for the Base Manufacturer role, click the Financial tab.

In addition to defining the Financial Period and Financial Payment Terms, the 
role computes various incoming and outgoing financial metrics. The 
Consumer role only computes outgoing financial metrics. 

To configure timing parameters, select the seconds, minutes, hours, days, or 
weeks that you want to configure, then use the up and down arrows to adjust the 
value, or enter the value directly:

See Also Configuring General Parameters for Roles in the e-SCOR User? Guide.

Configuring Financial Parameters for Roles in the e-SCOR User? Guide.

Assigning Products to Roles: Simplest Model
Next, you assign each product specification in the product hierarchy to one or 
more roles by configuring the products that each role in the model sources 
and/or delivers. In the simplest model, the Consumer role sources the product 
family, and the Base Manufacturer delivers the product family.

Role Parameter Value

Base
Manufacturer

Role Label Base Manufacturer

Consumer Role Label Consumer

seconds

minutes

hours

days

weeks
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When you assign a product specification to a role, e-SCOR creates the following 
objects, as appropriate for the role:

• Source product — The product that a buyer role sources from an upstream 
supplier role.

• Delivery product — The product that a supplier role delivers to a 
downstream buyer role.

Together, source and delivery products are called product composites.

Thus, when you assign a product specification to a Base Manufacturer role, 
e-SCOR creates a delivery product, and when you assign a product specification 
to a Consumer role, e-SCOR creates a source product. 

For Distributor and Manufacturer roles, you configure the products that the role 
both sources and delivers; thus, these roles define both source and delivery 
products, as you will learn later in this tutorial. 

e-SCOR places source and delivery products in the Products pool on the role 
detail. A pool is another type of container in which e-SCOR places objects that it 
creates and deletes when the simulation runs, such as awards, orders, and 
shipments.

To assign products to roles for the simplest model:

1 Display the properties dialog for the Base Manufacturer role and click the 
Product tab.

e-SCOR displays the list of all products associated with the model and the list 
of source and/or delivery products, depending on the type of role. In the 
simplest model, the product hierarchy consists of a single product 
specification. In a real model, the list of products would consists of finished 
products and their components.

For a Base Manufacturer, you specify the delivery products.

2 Click Product Family in the Delivery Products list and apply.

The Product Family is now a delivery product of the Base Manufacturer role.

For a Consumer role, you specify the source products.

3 Display the properties dialog for the Consumer role, click the Product tab, 
click Product Family in the Source Products list, and apply.

The Product Family is now a source product of the Consumer role.

To show which products are assigned to which roles:

 Right-click the role to display its popup menu and choose Show Products.
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Configuring Potential Suppliers for Source Products
Here is the delivery product associated with the Base Manufacturer role:

Here is the source product associated with the Consumer role:

The product composite associated with a Distributor role can be both a source and 
a delivery product.

See Also Configuring the Products a Role Sources and Delivers in the e-SCOR User? Guide.

Configuring Potential Suppliers for Source 
Products

Once you have assigned products to roles, the last step is to configure the 
potential suppliers for each source product in the model. In the simplest model, 
the Base Manufacturer role is the only potential supplier for the source product of 
the Consumer role. In a more realistic model, you might have multiple source 
products and multiple suppliers.

You configure potential suppliers by configuring the source product of a role. You 
will configure other parameters for source and delivery products later in this 
tutorial.

Product Family:
Is Source Product = false
Is Delivery Product = true

Product Family:
Is Source Product = true
Is Delivery Product = false
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To configure potential suppliers for source products:

1 Right-click the Consumer role to display its popup menu, choose Products to 
display the list of source and delivery products for the role, then choose 
Product Family to display the properties dialog for the source product.

Note From now, this tutorial does not explicitly instruct you to right-click an object 
to display its popup menu, then to choose a menu choice. Instead, it simply 
says to choose a particular menu choice on the object.

2 Click the Supplier Selection tab.

At the bottom of the dialog, you will see a list of all potential upstream 
suppliers for the source product. In the simplest model, only one upstream 
supplier exists, the Base Manufacturer role.

3 Check the Base Manufacturer role in the Potential Supplier Names list and 
accept.

The Consumer role is now configured to source the Product Family from the only 
upstream supplier in the model, the Base Manufacturer role. 

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Creating the Simplest Supply-Chain 
Model

To create and configure Level 1 roles for the simplest supply-chain model, you:

• Created the product specification.

• Created the supply-chain model.

• Configured role parameters.

• Assigned products to roles.

• Configured potential suppliers.

You should now know how to create and configure Level 1 roles for the simplest 
e-SCOR model. 

Next, you will run the simulation for the simplest e-SCOR model and view the 
metrics it computes.
28



4

Running the Simulation:
Simplest Model
Teaches you how to run the simulation and view Level 1 and Level 2 SCOR 
metrics through the Metrics toolbars.

Introduction 30

Running the Simulation 30

Troubleshooting Problems Running the Simulation 32

Viewing Role Metrics 32

Viewing Level 2 Metrics though the Toolbars 35

Saving the Model 36

Summary: Running the Simulation for the Simplest Model 36
29



Introduction
You run the simulation from the Simulation menu or toolbar. When you run the 
simulation, e-SCOR computes metrics for all roles, categories, and product 
composites in the model, which you can view through the properties dialogs, the 
Metrics toolbars, and output reports. 

In this section of the tutorial, you will:

• Run the simulation.

• Troubleshoot problems running the simulation.

• View role metrics through the properties dialogs and Metrics toolbars.

• View Level 2 metrics through the Metrics toolbars. 

Later in this tutorial, you will view Level 2 metrics through the dialogs, and you 
will create output reports for viewing metrics.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-simplest.kb, which shows the 
finished model. Follow along in the existing model as you read through the 
exercises.

Running the Simulation
When you run a simulation, the status of the Scenario object changes, depending 
on whether the model is running, paused, resetting, or stopped. 

As mentioned earlier, e-SCOR runs the simulation in jump mode, which 
processes each discrete event continuously and automatically advances the 
simulation clock with each new event.

To run the simulation:

1 Choose Start All from the Simulation menu or click the equivalent toolbar 
button: 

The status changes to resetting, then running.

Note Clicking the Start All button activates, resets, and starts the simulation 
running. Step 4 describes what happens when you reset the simulation.

e-SCOR verifies that you have configured the model correctly. If so, the 
simulation clock advances with each new event and computes metrics for all 
objects. 
30



Troubleshooting Problems Running the Simulation
In addition to computing metrics, objects begin flowing through the model. 
These objects represent purchase requests, purchase responses, purchase 
awards, orders, product shipments, invoices, and payments, which the model 
creates and deletes when it runs. By default, animation is off, which means 
you will not see these objects flowing through the model. 

2 Choose Pause from the Simulation menu or click the equivalent toolbar 
button to pause the simulation: 

The status changes to paused.

Pausing the simulation stops the simulation clock, causes all objects to stop 
flowing through the model, and stops computing metrics. 

3 Choose Continue from the Simulation menu or click the equivalent toolbar 
button to resume running the simulation after pausing:

The status changes to running.

The simulation clock begins advancing and the model continues to computes 
metrics.

4 Choose Reset from the Simulation menu or click the equivalent toolbar button 
to reset the simulation: 

The status changes from resetting to reset.

Resetting the simulation resets the simulation clock to the start time, deletes all 
objects the model has created, and resets all metrics to their initial values.

See Also Controlling the Simulation in the e-SCOR User? Guide.

Verifying that the Simulation is Running Correctly in the e-SCOR User? Guide.

Problems that Can Occur When Running a Simulation in the e-SCOR User? Guide.

Troubleshooting Problems Running the 
Simulation

The most common mistakes you can make when configuring a simple e-SCOR 
model are:

• You forget to assign product specifications to roles.

• You forget to configure the potential supplier of a source product.

• You did not label each role with a unique name.

If you do not configure the model correctly, e-SCOR immediately pauses the 
simulation and displays the detail of the category or role that is configured 
incorrectly. You will see a magenta arrow pointing to the object with the error. 
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You can drag the arrow away from the block to see the associated error message, 
which gives some indication of the error. You can also choose Message Board 
from the View menu to view these errors.

To correct configuration errors when running a simulation:

 Configure the model correctly, reset the simulation, and run the simulation 
again.

See Also Controlling the Simulation in the e-SCOR User? Guide.

Verifying that the Simulation is Running Correctly in the e-SCOR User? Guide.

Problems that Can Occur When Running a Simulation in the e-SCOR User? Guide.

Viewing Role Metrics
Each role computes the following metrics:

• Number of Financial Periods — The number of financial periods that have 
passed since the start of the simulation.

• Incoming financial metrics — Financial Bookings, Financial Outstanding, 
Financial Collections within Financial Period, and Financial Collections Total 
for products shipped. (See note below.)

• Outgoing financial metrics — Financial Obligations, Financial Payments 
within Financial Period, and Financial Payments Total for products received. 
(See note below.) 

• Days of supply metrics — Cost-weighted value of source product inventory 
(Raw Materials), source product inventory that has been taken from inventory 
but not yet assembled and shipped (Work in Progress), delivery product 
inventory that has not yet shipped (Finished Goods), and total inventory 
(Inventory Level). 

• Asset metrics — Standard asset calculations: Asset Turns, Cash-to-Cash Cycle 
Time, Days Sales Outstanding, and Cash Flow Period. 

• Order Management Costs — The total cost of doing business, which includes 
the cost of creating customer orders and delivering those orders, which is 0, 
by default.

A Consumer role computes only outgoing financial metrics, based on the net 
selling price of the upstream supplier’s delivery products. A Base Manufacturer 
computes incoming financial metrics from all its downstream buyers, as well as 
outgoing financial metrics, based on the purchase price of raw materials. 
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Viewing Role Metrics
Note The model computes total financial collections and payments, financial bookings, 
financial outstanding, and financial obligations since the start of the simulation 
with each new event; therefore, these metrics are always current. The model 
computes financial collections and payments within the financial period at the 
end of each period; therefore, these metrics refer to collections and payments for 
the previous financial period. 

The financial and asset metrics for roles require that at least one financial cycle 
complete before the role begins computing values. 

When you view metrics through the dialogs, e-SCOR takes a snapshot at a 
particular point in time and updates the values once every few seconds. You can 
also manually update the metrics to view the latest values by clicking the Update 
button in the dialog.

When you view financial metrics through the Metrics toolbar, the values update 
automatically. 

For those metrics that are based on historical values, you can also view statistical 
calculations, such as minimum and maximum values, and averages, and you can 
view the history. You view these values through the properties dialog.

To view metrics for the Base Manufacturer and Consumer roles:

1 Run the simulation again.

2 Choose View > Financial Metrics.

A spreadsheet of financial metrics appears at the bottom of the window. The 
financial collections and payments begin to update after one financial period 
has completed.

3 Choose View > Asset Metrics.

A spreadsheet of asset metrics appears at the bottom of the window. 
Similarly, the asset metrics begin to update after one financial period has 
completed. 

4 Wait until at least four months of simulation time has past, which is four 
financial periods.

The simulation time should be some time after May 1. Now, you will view the 
metrics through the dialogs.
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5 Display the properties dialog for each role to view these metrics on these tabs:

6 Click the button next to any of the metrics that are calculated based on a 
history, such as Financial Bookings. 

The Metrics tab shows statistical values calculated for the metric. You can also 
configure various properties and keep a history.

7 Pause the simulation.

Tab Group/Metric

Role Number of End Products

Financial General
Number of Financial Periods

Incoming
Financial Bookings
Financial Outstanding
Financial Collections within Financial Period
Financial Collections Total

Outgoing
Financial Obligations
Financial Payments within Financial Period
Financial Payments Total

Assets Days of Supply
Raw Materials 
Work in Progress
Finished Goods 
Inventory 

Metrics
Asset Turns
Cash-to-Cash Cycle Time
Days Sales Outstanding
Cash Flow Period

Cost Order Management Costs
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Viewing Level 2 Metrics though the Toolbars
Here are the Financial and Asset Metrics toolbars after 4 financial periods have 
passed:

See Also Viewing Metrics for Roles in the e-SCOR User? Guide.

Viewing Level 2 Metrics though the Toolbars
You can view Level 2 metrics related to orders, inventory, and contracts in the 
Metrics toolbars. 

To view Level 2 metrics through the toolbars:

1 Choose View > Order Metrics.

The Order Metrics toolbar includes metrics related to orders for all source and 
delivery products in the model, including order fulfillment times.

2 Choose View > Inventory Metrics.

The Inventory Metrics toolbar includes metrics related to inventory levels for 
all source and delivery products in the model.

3 Choose View > Contract Metrics.

The Contract Metrics toolbar includes metrics related to contracts for all 
source and delivery products in the model.

4 Reset the simulation.
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Here are the Order, Inventory, and Contract Metrics toolbars after 4 financial 
periods have passed:

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Running the Simulation for the 
Simplest Model

To run the simulation for the simplest model, you:

• Ran the simulation.

• Troubleshot problems running the simulation.

• Viewed role metrics.

• Viewed Level 2 metrics through the toolbars.

You should now know how to view metrics for Level 2 categories and product 
composites for the simplest e-SCOR model. 

Next, you will configure the simplest model to generate output reports for 
viewing metrics in an Excel spreadsheet.
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Introduction
Each role has detail, which provides the default configuration of Level 2 SCOR for 
the particular role. Level 2 SCOR includes:

• Process categories, which define how the role plans, sources, makes, and 
delivers products, as appropriate for the role.

• Product composites, which define the source and delivery products that a role 
sources and/or delivers.

Process categories are also referred to simply as “categories.”

You configure various parameters for each category and each product composite 
on the role detail. The parameters you configure for categories apply to all 
products the role sources, makes, and/or delivers, such as the time it takes to 
manufacture a batch of products. On the other hand, the parameters you 
configure for product composites apply to individual source and delivery 
products, such as the starting and maximum inventory for a particular product.

You configure Level 2 SCOR parameters on the various tab pages of the 
properties dialog for categories and product composites. These dialogs also 
include metrics the model computes for each category and product composite.

For a quick reference to the definition of all parameters and metrics, see the 
e-SCOR Quick Reference. For the SCOR definition of all SCOR metrics, see 
Appendix B, SCOR Metrics in the webSCOR User? Guidee-SCOR User? Guide. 

To configure Level 2 SCOR for the simplest model, you:

• View the Consumer role detail, then configure:

– Source category parameters

• View the Base Manufacturer role detail, then configure:

– Make category parameters

– Plan category parameters

– Deliver category parameters

• Configure product composite parameters

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-simplest.kb, which shows the 
finished model. Follow along in the existing model as you read through the 
exercises.
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Viewing the Consumer Role Detail
See Also Process Category Summary in the e-SCOR User? Guide.

Configuring Category Parameters in the e-SCOR User? Guide.

Configuring Product Composites in the e-SCOR User? Guide.

Viewing the Consumer Role Detail
The Consumer role detail includes these process categories related to sourcing 
stock products, which is the default planning strategy:

• ES: Enable Source category, which is responsible for sending customer 
orders—orders for source products with upstream suppliers—and 
establishing contracts with those suppliers.

• S1: Source Stocked Product category, which is responsible for placing orders 
and change orders for the finished products that the overall supply chain 
consumes, receiving orders for stock finished products, and making payments 
to suppliers.

The Consumer role contains two additional categories, which represent boundary 
conditions:

• Input, which signals the beginning of the supply-chain process when orders 
for finished products are placed.

• End, which signals the end of the supply-chain process when the finished 
products in the supply chain have been received.

You configure the frequency with which the Consumer role places orders for its 
source products and the size of those orders in the source product of the 
Consumer role, which you will do later in this tutorial.

Distributor and Manufacturer roles also contain the ES: Enable Source and 
S1: Source Stocked Product categories on the role detail. Customer orders that 
originate in a Distributor or Manufacturer role are also known as replenishment 
orders.

Consumer, Distributor, and Manufacturer roles also contain the S2: Source Make-
to-Order Product and S3: Source Engineer-to-Order Product process categories 
for sourcing products, using alternative planning strategies.

To view the Consumer role detail:

 Choose Show Detail on the Consumer role.

Tip Remember, you can also press Ctrl + right-click to display the detail.
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See Also Viewing Role Details in the e-SCOR User? Guide.

Configuring Source Category Parameters: 
Consumer Role

The Source category of a role is responsible for receiving shipments from and 
making payments to suppliers. You configure timing parameters related to 
receiving and verifying source products and placing them in inventory. 

You configure all timing parameters, based on one of a number of mathematical 
distributions, including random triangular, random normal, and random 
exponential. The default distribution for all timing parameters is random 
triangular, where the minimum, maximum, and mode are all 1 hour; therefore, 
the duration is fixed. 

You also configure cost parameters related to acquiring products, creating orders, 
verifying and receiving shipments, and making payments. In this tutorial, the 
costs are specified as US dollars, however, in general, you configure costs as 
currency units.

Distributor and Manufacturer roles use source planning to determine the size of 
each replenishment order for source products and when to place an order, based 
on orders for its delivery products. 

Because a Consumer role has no downstream buyers, it places orders for its 
source products, based on parameters that you configure in the source product, 
which you will do later in this tutorial. These parameters determine the overall 
demand for finished products in the supply chain. 

Configure these parameters for the S1 category:

• Receiving Duration, Verification Duration, Transfer Duration — Takes an 
average of 1 hour each to receive, verify, and transfer source products, using a 
triangular distribution, the default.

• Costs per Transaction parameters — Costs $10 to receive the source product 
(Receiving), verify the shipment (Verification), transfer the shipment 
(Transfer), create an order (Create Customer Order), and pay an invoice 
(Invoice).
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Configuring Source Category Parameters: Consumer Role
To configure Source category parameters for the Consumer role:

 Configure these parameters for the S1: Source Stocked Product category on 
the Consumer role detail:

See Also Configuring the Source Category in the e-SCOR User? Guide.

Configuring the Mathematical Distribution in the e-SCOR User? Guide.

Tab Group/Parameter Value

Receiving Receiving Duration
Duration Mode
Min
Max
Mode

Random Triangular
30 minutes
1 hour and 30 minutes
1 hour

Verification Verification Duration
Duration Mode
Min
Max
Mode

Random Triangular
30 minutes
1 hour and 30 minutes
1 hour

Transfer Transfer Duration
Duration Mode
Min
Max
Mode

Random Triangular
30 minutes
1 hour and 30 minutes
1 hour 

Cost Costs per Transaction
Receiving
Verification
Transfer
Create Customer Order
Invoice

10
10
10
10
10
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Viewing Base Manufacturer Role Details
The Base Manufacturer role detail includes these process categories related to 
manufacturing and distributing stock products, the default:

• Mb: Make Product category, which defines the cost of raw materials in the 
supply chain and the manufacturing time for making batches of finished 
products.

• P3: Plan Make category, which defines the frequency with which the role 
creates build orders, which are orders for delivery products that the role 
sends to manufacturing, and implicitly determines when the role delivers 
those products.

• D1: Deliver Stocked Product category, which defines the amount of time it 
takes to enter an order for stock products, the criteria the role uses to 
determine which orders to deliver first, and various timing parameters related 
to delivering products.

• ED: Enable Deliver category, which is responsible for establishing contracts 
with and receiving orders from downstream buyers for delivery products. 
The ED category has no configurable parameters.

Base Manufacturer roles use the Mb category as its Make category. Manufacturer 
roles include the M1: Make-to-Stock category for manufacturing stock finished 
products, the default, as well as the M2: Make-to-Order and M3: Engineer-to-
Order categories for making products, using alternative planning strategies. 

Base Manufacturer and Manufacturer roles use the P3: Plan Make category on the 
role detail for make planning. Make planning determines the number of finished 
products a manufacturer role makes and the frequency with which it sends build 
orders to manufacturing. 

Base Manufacturer, Distributor, and Manufacturer roles include the D1: Deliver 
Stocked Product category for delivering stock finished products, the default. They 
also include the D2: Deliver Make-to-Order Product and D3: Deliver Engineer-to-
Order Product categories for delivering products, using alternative planning 
strategies.

Base Manufacturer, Distributor, and Manufacturer roles all include the 
ED: Enable Deliver category on the role detail. 

To view the Base Manufacturer role detail:

 Choose Show Detail on the Base Manufacturer role.

See Also Viewing Role Details in the e-SCOR User? Guide.
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Configuring Make Category Parameters: Base Manufacturer Role
Configuring Make Category Parameters: Base 
Manufacturer Role

The Make category is responsible for selecting build orders for manufacture and 
manufacturing delivery products. Therefore, you configure timing and build-
selection parameters related to manufacturing delivery products.

Base Manufacturer and Manufacturer roles use make planning to determine the 
size of each build order and when to start manufacturing batches, based on orders 
for its delivery products. Therefore, you configure planning parameters in the 
P3: Plan Make category and in the delivery products for the role. 

By default, Base Manufacturer roles use a stock planning strategy to determine 
build order size, based on orders for its delivery products. If the role uses an 
engineer-to-order planning strategy, you configure additional parameters for the 
Base Manufacturer role related to engineering duration and costs. 

By default, a Base Manufacturer or Manufacturer role that makes stock products 
chooses build orders at random. You can configure various build-selection 
criteria in the Make category for choosing build orders. 

Configure these parameters for the Mb category:

• Order Release to Manufacturing Duration — Takes 1 day, on average, from 
when the role receives a build order to when it begins manufacturing batches 
of finished products.

• Build Selection parameters — Chooses the largest build orders first.

• Production Material Duration — Takes 1 day, on average, from when the 
Make category receives components to when it starts manufacturing batches 
of finished products.

• Manufacturing Duration — Takes 10 hours, on average, to manufacture a 
batch of finished products.

• Move to Delivery Duration — Takes 1 hour, on average, to place the finished 
products in inventory.

• Production Material Handling — The costs associated with handling the 
components the Make category uses to manufacture finished products. 
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To configure Make category parameters for the Base Manufacturer role:

 Configure these parameters for the Mb: Make Product category on the 
Base Manufacturer role detail: 

See Also Configuring the Make Category in the e-SCOR User? Guide.

Tab Group/Parameter Value

Build Orders Order Release to Manufacturing 
Duration

Distribution Mode
Min
Max
Mode

Random Triangular
12 hours
1 day and 12 hours
1 day 

Build Selection 1-2 First
First Sort Direction
First Sort Criteria

Biggest 
Order Size

Production Material Production Material Duration
Distribution Mode
Min
Max
Mode

Random Triangular
12 hours
1 day and 12 hours
1 day 

Manufacturing Manufacturing Duration
Distribution Mode
Min
Max
Mode

Random Triangular
9 hours
11 hours
10 hours

Transfer Move to Delivery Duration
Distribution Mode
Min
Max
Mode

Random Triangular
12 hours
1 day and 12 hours
1 day 

Cost Costs Incurred
Production Material Handling 10
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Configuring Plan Category Parameters: Base Manufacturer Role
Configuring Plan Category Parameters: Base 
Manufacturer Role

The Plan category is responsible for computing the size of an order, the frequency 
with which to create orders, when to place the first order, and to whom to ship 
each order. Base Manufacturer and Manufacturer roles use make planning to 
determine the size of each build order. Distributor and Manufacturer roles use 
source planning to determine the size of each replenishment order.

By default, the Plan category uses cyclic planning to determine when to create 
build orders or replenishment orders; therefore, you configure timing parameters 
related to the planning period and the initial delay before creating the first plan. 
You can also configure the Plan category to use continuous planning, also known 
as demand-based planning, which causes the role to create build orders or 
replenishment orders whenever the downstream buyer places an order for the 
role’s delivery products. 

You configure planning parameters related to safety stocks, order quantities, 
inventory control planning strategies, and build yield in the source and delivery 
products for the role, which you will do later in this tutorial.

Configure these parameters for the P3 category:

• Planning Period — Initiates a plan once every 2 weeks.

• Initial Plan Delay — Waits 2 days before initiating its first plan, the default.

• Continuous Planning — Performs cyclic planning, the default.

• Compensate for Yield — Compensates for lower yield rates when 
determining build order size, the default.

To configure Plan category parameters for the Base Manufacturer role:

 Configure these parameters for the P3: Plan Make category on the Base 
Manufacturer role detail:

See Also Configuring the Plan Category in the e-SCOR User? Guide.

Tab Group/Parameter Value

Planning Planning
Planning Period
Initial Plan Delay
Continuous Planning
Compensate for Yield

2 weeks
2 days (default)
off (default)
on (default)
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Configuring Deliver Category Parameters: Base 
Manufacturer Role

The Deliver category is responsible for entering and choosing orders for 
shipments, picking delivery products from inventory, packing containers, 
shipping containers to buyers, and invoicing and receiving payments from 
buyers. You configure timing and cost parameters related to processing and 
fulfilling orders for delivery products.

By default, a role chooses orders for shipment at random. You can configure the 
criteria the role uses for choosing orders for shipment for stock delivery products. 
For example, you can deliver orders on a first-in first-out basis, or you can deliver 
the most expensive orders first. 

Configure these parameters for the D1 category:

• Order Entry Duration — Takes 1 day, on average, to enter an order for 
delivery products from when the order is received.

• Order Selection parameters — Chooses orders for shipment on a first-in 
first-out basis, by sorting orders based on the smallest Internal Order Number 
first.

• Pick Duration and Packing Duration — Takes 1 hour, on average, to pick 
delivery products from inventory and to pack a container for shipment.

• Transportation Duration — Takes 3 days, on average, to ship a container of 
delivery products.

• Costs Per Transaction parameters — Costs $10 to enter an order for delivery 
products (Order Entry), fulfill the order (Order Fulfillment), pick delivery 
products from inventory (Pick), pack containers for shipment (Packing), ship 
the container (Transportation), invoice customers (Customer Invoicing), and 
receive payments for each order (Customer Collections).
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Configuring Deliver Category Parameters: Base Manufacturer Role
To configure Deliver category parameters for the Base Manufacturer role:

 Configure these parameters for the D1: Deliver Stocked Product category on 
the Base Manufacturer role detail:

See Also Configuring the Deliver Category in the e-SCOR User? Guide.

Tab Group/Parameter Value

Order Order Entry Duration
Distribution Mode
Min
Max
Mode

Random Triangular
12 hours
1 day and 12 hours
1 day 

Order 
Selection 1-2

First
First Sort Direction
First Sort Criteria

Smallest 
Internal Order Number

Fulfillment Pick Duration
Distribution Mode
Min
Max
Mode

Random Triangular
30 minutes
1 hour and 30 minutes
1 hour 

Packing Duration
Distribution Mode
Min
Max
Mode

Random Triangular
30 minutes
1 hour and 30 minutes
1 hour 

Transportation Transportation Duration
Distribution Mode
Min
Max
Mode

Random Triangular
2 days
4 days
3 days

Cost Costs per Transaction
Order Entry
Order Fulfillment
Pick
Packing
Transportation
Customer Invoicing
Customer Collections

10
10
10
10
10
10
10
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Configuring Product Composite Parameters
When you assign a product to a role, e-SCOR creates product composites for the 
various roles, as follows:

• A Base Manufacturer role has only delivery products.

• A Consumer role has only source products.

• A Manufacturer role has both source and delivery products, where the source 
products are components and the delivery products are finished products.

• A Distributor role that delivers its source products has both source and 
delivery products, where the source and delivery products are the same.

• A Distributor role that assembles components into kits has both source and 
delivery products, just like a Manufacturer role.

You will create and view product composites for Distributor and Manufacturer 
roles later in this tutorial.

You configure various parameters for product composites, depending on whether 
it is a source or delivery product, and depending on the role. The dialog tab pages 
determine which parameters you need to configure, as follows:

Tab Description

General Order type and preferences for both source and delivery 
products of buyer and supplier roles.

Demand Consumer demand order start and stop time, demand input 
report, demand order duration, and demand order size for 
source products of Consumer roles only. 

MRO Enables MRO, specifies maintenance, repair, and overhaul 
parameters.

Sourcing Purchase cost for the raw materials of Base Manufacturer 
roles only.

Supplier Order fulfillment parameters, push planning, and contract 
and forecast amount for source products of buyer roles.

Supplier 
Selection

Potential and maximum number of suppliers, selection 
criteria for choosing suppliers, and whether and how to split 
orders between suppliers for buyer roles.
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Configuring Product Composite Parameters
You can configure multiple product composites at the same time through a report 
rather than using dialogs, which you will do later in this tutorial.

You can use one of several techniques for configuring product composite 
parameters for the Base Manufacturer and Consumer roles.

To configure product composite parameters:

 Choose Products on the role, then choose the product whose parameters you 
want to configure to display the properties dialog directly.

or

 Choose Show Products on the role to display the detail of the Products pool, 
then display the properties dialog for the product composite whose 
parameters you want to configure.

or

 Show the role detail, choose Show Detail on the Products pool, then display 
the properties dialog for the product composite whose parameters you want 
to configure.

Next, you will configure various parameters for each product composite.

See Also Default Source and Delivery Products for Each Role in the e-SCOR User? Guide.

Configuring Product Composite Parameters in the e-SCOR User? Guide.

Inventory Initial and maximum inventory, inventory control strategy, 
safety stock, and minimum reorder quantities for both source 
and delivery products of Base Manufacturer, Distributor, and 
Manufacturer roles. You do not configure inventory 
parameters for Consumer roles.

Manufacturing Batch and yield parameters for delivery products of 
Manufacturer roles only.

Return Defective, excess, and MRO return authorization yield for 
delivery products of supplier roles.

Delivery Published lead time and selling price for delivery products of 
supplier roles.

Multipliers When sourcing and delivering multiple products, multipliers 
for configuring variation in timing parameters for source and 
delivery products.

Tab Description
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Configuring Source Product Parameters: Consumer 
Role

The Input block of the Consumer role is responsible for placing orders with 
upstream suppliers for finished products in the overall supply chain. Because a 
Consumer role has no downstream buyers, unlike a Distributor or Manufacturer 
role, it does not use source planning to determine order size. Instead, it places 
orders for its source products, based on parameters that you configure in the 
source product. You configure the Demand Start Time, Demand Stop Time, 
Demand Order Duration, and Demand Order Size for generating orders. 

If you have demand data in a tabular format, you can configure when to place 
orders and the order size through a Demand Report. You can also configure 
change orders through a Demand Report, which allows you to change various 
information about an order that has already been placed but not yet delivered.

A Consumer role creates orders for its source products on a cyclical basis, based 
on parameters that you configure in the source product, rather than based on 
source planning. Therefore, you do not configure parameters for the source 
product of a Consumer role related to inventory planning. 

By default, if a buyer role has multiple upstream supplier roles for the same 
source product, it chooses the supplier based on the lowest product price. You can 
configure parameters on the Supplier Selection tab for choosing one or more 
suppliers. You can also configure the buyer role to use contracts when placing 
orders for source products by configuring parameters on the Supplier tab of the 
source product. 

In the simplest e-SCOR model, the Consumer role sources products from a single 
upstream supplier; therefore, the only parameters you need to configure related 
to the supplier is the potential supplier, the desired turnaround time, and the 
fulfillment preference.

Configure the source product parameters on the following tabs for the 
Consumer role:

• General tab:

– Order Type — Uses a stock planning strategy for sourcing products, the 
default.

• Demand tab:

– Demand Order Duration — Generates orders once a week, using a 
random exponential distribution.

– Demand Order Size — Generates orders for 10 source products, plus or 
minus 5, using the default start and stop times. 

• Supplier tab:
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Configuring Product Composite Parameters
– Desired Turnaround — Requests that suppliers deliver orders for source 
products within 1 week of receiving them, the default.

– Fulfillment Preference — Fulfills only complete orders; does not allow 
partial shipments, the default.

• Supplier Selection tab:

– Potential Suppliers — Sources products from the Base Manufacturer role.

To configure source product parameters for the Consumer role:

 Configure these parameters for the source product of the Consumer role:

See Also Configuring Parameters for Source Products in the e-SCOR User? Guide.

Configuring the Mathematical Distribution in the e-SCOR User? Guide.

Configuring Demand and Change Orders through a Demand Report in the e-

SCOR User? Guide.

Tab Group/Parameter Value

General General
Order Type stock (default)

Demand Demand Order Duration
Distribution Mode
Mean

Random Exponential
1 week

Demand Order Size
Distribution Mode
Min
Max
Mode

Random Triangular
5
15
10

Supplier Policy
Desired Turnaround
Fulfillment Preference

1 week (default)
Whole (default)

Supplier 
Selection

Potential Suppliers
Potential Suppliers Base Manufacturer
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Configuring Delivery Product Parameters: Base 
Manufacturer

You configure inventory and planning parameters for the delivery products of 
each supplier role in the model. You also configure parameters related to selling 
price, published lead time, batch size, and manufacturing yield.

The Order Type of the delivery product determines the planning strategy a role 
uses for making and delivering products—stock, make-to-order, or engineer-to-
order. The role uses make planning to determine the size of each build order and 
when the role manufactures each build order.

Normally, the upstream suppliers’ delivery product determines the selling price 
buyers must pay for their source products. However, because a Base 
Manufacturer role has no upstream suppliers, it determines the price it pays for 
its source products, based on the Purchase Cost parameter, which you configure 
for the delivery product of the Base Manufacturer role.

Note Normally, the Purchase Cost is a metric that the model computes for buyer roles 
in the model; however, for a Base Manufacturer role only, Purchase Cost is a 
parameter that you configure.

If the role manufactures multiple delivery products, you can configure the 
Product Preference for each delivery product when choosing orders for shipment, 
based on preference. 

By default, each role uses a pull planning mode, which means that downstream 
buyer roles place orders with suppliers for their source products, based on source 
planning. Source planning determines the number of source products a buyer role 
orders and the frequency of those orders. 

You can also configure a role to use a push planning mode, in which case the 
upstream supplier role determines how many products it delivers, based on 
contracts and forecasts. You can combine pull and push planning modes between 
roles and within the same role to use different types of planning at each stage in 
the supply chain. For example, a Manufacturer role might source components, 
using a pull planning strategy, but it might deliver finished products, using a 
push planning strategy.

If the role is one of multiple suppliers for the same delivery product to a single 
downstream buyer, you can configure various parameters for each delivery 
product for choosing the supplier, based on contracts.

If the role sources, makes, or delivers multiple products, you can configure 
various multipliers for each source and delivery product to model variation in 
timing parameters for each product. The simplest e-SCOR model sources and 
delivers a single product only; therefore, typically, you do not configure these 
multipliers.
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Configuring Product Composite Parameters
Configure the delivery product parameters on the following tabs for the Base 
Manufacturer role:

• General tab:

– Order Type — Uses a stock planning strategy for making and delivering 
delivery products, the default.

• Inventory tab:

– Starting Product Inventory Level — Has 100 units of delivery product in 
inventory when the simulation starts.

– Maximum Inventory Level — Can hold a maximum of 1000 delivery 
products in inventory.

– Inventory Control Strategy — Uses a stock/replenishment inventory 
control strategy to determine how the role computes build-order size 
when manufacturing stock delivery products, the default.

– Safety Stock — Keeps 50 units of delivery product in inventory as a safety 
stock.

– Minimum Reorder Quantity — Creates build orders for a minimum of 10 
delivery products when creating replenishment orders.

• Sourcing tab:

– Purchase Cost — Costs $100 for raw materials to manufacture a delivery 
product.

• Manufacture tab:

– Build Time Dependent on Order Size — Adjusts the build time of the 
Make category to be proportional to the size of the build order. 

– Minimum Batch Size and Maximum Batch Size — Manufactures delivery 
products with a minimum batch size of 30 units and a maximum batch 
size of 50 units.

– Build Yield — Has a 95% yield during the manufacturing process.

• Delivery tab:

– Published Delivery Lead Time — Tells buyers that it can turn around 
orders for products in 5 days.

– Net Selling Price — Charges $250 as the selling price for each product it 
delivers to buyers.
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To configure the delivery product for the Base Manufacturer role:

 Configure these parameters for the delivery product of the Base Manufacturer 
role:

See Also Configuring Parameters for Delivery Products in the e-SCOR User? Guide.

Configuring Multipliers for Timing Parameters in the e-SCOR User? Guide.

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Tab Parameter Value

General General
Order Type stock (default)

Inventory Policy
Starting Product Inventory Level
Maximum Inventory Level
Inventory Control Strategy
Safety Stock
Minimum Reorder Quantity

100
1000
replenishment
50
10

Sourcing Policy
Purchase Cost 100

Manufacturing Policy
Build Time Dependent on Order Size
Minimum Batch Size
Maximum Batch Size
Build Yield

true
30
50
.95

Delivery Policy
Published Delivery Lead Time
Net Selling Price

5 days
250
54



Summary: Configuring Level 2 SCOR
Summary: Configuring Level 2 SCOR
To configure Level 2 SCOR for the simplest e-SCOR model, you:

• Viewed Consumer role details.

• Configured Source category parameters.

• Viewed Base Manufacturer role details.

• Configured Make category parameters.

• Configured Plan category parameters.

• Configured Deliver category parameters.

• Configured product composite parameters

You should now know how to configure Level 2 SCOR parameters for categories 
and product composites for the simplest e-SCOR model. 

Next, you will run the simulation and view metrics for Level 2 categories and 
product composites.
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6

Viewing Level 2 Metrics:
Simplest Model
Teaches you how to view metrics for Level 2 categories and product composites 
through the dialogs.
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Viewing ED: Enable Deliver Category Metrics 64
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Introduction
Now that you have configured Level 2 category and product composite 
parameters, you will run the simulation again and view the following Level 2 
category and product composite metrics:

• Source category metrics.

• ES: Enable Source category metrics.

• Deliver category metrics.

• ED: Enable Deliver category metrics.

• Make category metrics.

• Plan category metrics.

• Delivery product metrics.

• Source product metrics.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-simplest.kb, which shows the 
finished model. Follow along in the existing model as you read through the 
exercises.

Viewing Source Category Metrics
The S1: Source Stocked Product category computes these metrics for all stock 
source products:

• Orders Sent and Change Orders Sent — The number of orders and the 
number of change orders sent to the supplier since the start of the simulation.

• Product Shipments Received — The number of product shipments received 
since the start of the simulation.

• Product Shipment Lead Time — The product shipment lead time, which is the 
difference between the Desired Turnaround of the source product and the 
actual delivery time of the current shipment of source products, as a delta. A 
positive number indicates the shipment was early, and a negative number 
indicates the shipment was late.

• Outgoing financial metrics — Financial Obligations, Financial Payments 
within Financial Period, and Financial Payments Total for individual source 
products that use the same planning strategy—stock, make-to-order, or 
engineer-to-order.
58



Viewing ES: Enable Source Category Metrics
• Cost Incurred metrics — The total cost of receiving source products 
(Receiving Metric), verifying orders (Verification Metric), transferring source 
products to inventory (Transfer Metric), creating customer orders for source 
products (Create Customer Order Metric), and paying invoices for those 
orders (Invoice Metric) since the start of the simulation.

To view Source category metrics for the Consumer role:

 Run the simulation for approximately one year of simulation time, then pause 
the simulation and display the properties dialog for the S1: Source Stocked 
Product category on the Consumer role detail to view these metrics:

See Also Viewing Metrics for the Source Categories in the e-SCOR User? Guide.

Viewing ES: Enable Source Category Metrics
The ES: Enable Source category computes these metrics for all source products:

• Orders Sent and Change Orders Sent — The number of orders and the 
number of change orders sent to the supplier since the start of the simulation.

• Product Shipments Received — The number of product shipments received 
since the start of the simulation.

• Contracts Established — The number of contracts the role has established 
with upstream suppliers. In the simplest model, when the first contract is 

Tab Group/Metric

Source Metrics
Orders Sent
Change Orders Sent
Product Shipments Received
Product Shipment Lead Time 

Financial Outgoing
Financial Obligations
Financial Payments within Financial Period
Financial Payments Total

Cost Cost Incurred
Receiving Metric
Verification Metric
Transfer Metric
Create Customer Order Metric
Invoice Metric
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established, the number of contracts established is 1, which means the buyer 
role has a single supplier for its source products. The buyer might have 
several suppliers, in which case the number of contracts established could be a 
number greater than 1.

• Supplier On-Time Performance (%) — The percentage of shipments that the 
role has received on or before the customer request date, which is the Desired 
Turnaround of the role’s source product.

When you run the simulation, the Supplier On-Time Performance should be 
approximately 90%.

To view ES: Enable Source category metrics for the Consumer role:

 Display the properties dialog for the ES: Enable Source category on the 
Consumer role detail and view these metrics:

See Also Viewing Metrics for the ES: Enable Source Category in the e-SCOR User? Guide.

Viewing Make Category Metrics
The Mb: Make Product category computes these metrics for all delivery products 
that use the same planning strategy:

• Build Orders Started and Build Orders Completed — The number of build 
orders started and completed since the start of the simulation.

• Make Cycle Time — The average time it takes from when the role receives a 
build order for delivery products to when it finishes manufacturing those 
products.

• Order Entry to Manufacturing Time — The amount of time from when the 
downstream Deliver category creates a replenishment order to when the 
Make category starts manufacturing the build order. This metric is computed 
for the Mb and M3 categories for ETO products only.

When you run the simulation, the Make Cycle Time should be approximately 
3 days.

Tab Group/Metric

Source Metrics
Orders Sent
Change Orders Sent
Product Shipments Received
Contracts Established
Supplier On-Time Performance (%)
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Viewing Plan Category Metrics
To view Make category metrics for the Base Manufacturer role:

 Display the properties dialog for the Mb: Make Product category on the Base 
Manufacturer role detail and view these metrics:

See Also Viewing Metrics for the Make Categories in the e-SCOR User? Guide.

Viewing Plan Category Metrics
The P2: Plan Source and P3: Plan Make categories compute the number of 
planning periods that have passed since that start of the simulation.

To view Plan category metrics for the Base Manufacturer role:

 Display the properties dialog for the P3: Plan Make category on the Base 
Manufacturer role detail and view this metric:

See Also Viewing Metrics for the Plan Categories in the e-SCOR User? Guide.

Viewing Deliver Category Metrics
The D1: Deliver Stocked Product category computes these metrics for all stock 
delivery products:

• Orders Received and Change Orders Received — The number of orders and 
the number of change orders received since the start of the simulation.

• Product Shipments Sent — The number of product shipments sent since the 
start of the simulation.

Tab Group/Metric

Manufacturer Metrics
Build Orders Started
Build Orders Completed
Make Cycle Time
Order Entry to Manufacturing Time

Tab Group/Metric

Planning Planning
Number of Planning Periods
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• Fill Rates (%) — The percentage of orders the role has delivered within 24 
hours of receiving the order.

• Ready to Ship Time — The number of days it takes to pick delivery products 
from inventory and pack containers.

• Order Entry to Ship Time — The average number of days from when the role 
receives an order to when the order is actually ready to ship.

• Incoming financial metrics — The Financial Bookings, Financial Outstanding, 
Financial Collections within Financial Period, and Financial Collections Total 
for delivery products.

• Costs Incurred metrics — The total cost of entering orders for delivery 
products (Order Entry Metric), fulfilling orders (Order Fulfillment Metric), 
picking delivery products from inventory (Pick Metric), packing shipments 
(Packing Metric), transporting shipments (Transportation Metric), sending 
invoices (Customer Invoicing Metric), and collecting payments (Customer 
Collections Metric).

The Fill Rates should be approximately 80%, the Ready to Ship Time should be 
approximately 2 hours, and the Order Entry to Ship Time should be 
approximately 3 days.

To view Deliver category metrics for the Base Manufacturer role:

 Display the properties dialog for the D1: Deliver Stocked Products category 
on the Base Manufacturer role detail and view these metrics:

Tab Group/Metric

Delivery Metrics
Orders Received
Change Orders Received
Product Shipments Sent
Fill Rates (%)
Ready to Ship Time
Order Entry to Ship Time 
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Viewing ED: Enable Deliver Category Metrics
See Also Viewing Metrics for the Deliver Categories in the e-SCOR User? Guide.

Viewing ED: Enable Deliver Category Metrics
The ED: Enable Deliver category computes these metrics for all delivery products:

• Order Received and Change Orders Received — The number of orders and 
the number of change orders received since the start of the simulation.

• Product Shipments Sent — The number of product shipments sent since the 
start of the simulation.

• Contracts Established — The number of contracts the supplier has established 
with downstream buyers. For the simplest model, when the first contract is 
established, the number of contracts established is 1, which means the 
supplier has a single downstream buyer for its delivery products. 

• Delivery Performance (%)— The percentage of orders that the role has 
delivered on or before the customer request date, which is the Desired 
Turnaround parameter of the source product of the downstream buyer role.

• Perfect Order Fulfillment (%) — The percentage of orders that the role has 
delivered on or before the customer request date and for the requested 
quantities.

The Delivery Performance (%) and Perfect Order Fulfillment (%) should both be 
approximately 80%.

Financial Incoming
Financial Bookings
Financial Outstanding
Financial Collections within Financial Period
Financial Collections Total

Cost Costs Incurred 
Order Entry Metric
Order Fulfillment Metric
Pick Metric
Packing Metric
Transportation Metric
Customer Invoicing Metric
Customer Collections Metric

Tab Group/Metric
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To view ED: Enable Deliver category metrics for the Base Manufacturer role:

 Display the properties dialog for the ED: Enable Deliver category on the Base 
Manufacturer role detail and view these metrics:

See Also Viewing Metrics for the ED: Enable Deliver Category in the e-SCOR User? Guide.

Viewing Delivery Product Metrics: Base 
Manufacturer Role

The delivery product of a Base Manufacturer role computes:

• Quantity to Deliver and Quantity Shipped — The number of orders for this 
delivery product that the supplier has received and the number of delivery 
products that have been shipped since the start of the simulation.

• Total Products Accepted and Total Products Rejected — The number of 
delivery products that have been accepted and rejected, which is based on the 
Build Yield parameter of the role’s delivery product.

• Awaiting Orders — The current number of delivery products that 
downstream buyers have ordered and the supplier has entered, but the 
supplier has not yet delivered.

• Products On Order — The number of delivery products for which the make 
planning process has created build orders but which the Deliver category of 
the supplier has not yet received. 

• Received Inventory Level —The number of delivery products that the 
supplier has manufactured and placed in inventory since the start of the 
simulation.

• Inventory Level —The current inventory level for this delivery product.

• In Transit Inventory Level — The number of delivery products that the 
supplier has taken from inventory and is waiting to deliver.

Tab Group/Metric

Delivery Metrics
Orders Received
Change Orders Received
Product Shipments Sent
Contracts Established
Delivery Performance (%)
Perfect Order Fulfillment (%)
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Viewing Delivery Product Metrics: Base Manufacturer Role
• Shipped Inventory Level — The number of delivery products that the role has 
manufactured and shipped since the start of the simulation.

• Pushed Inventory Level — The number of delivery products that the supplier 
has delivered to downstream buyers, using a push planning strategy, since 
the start of the simulation. 

• Manufacturing Batch Size — The size of the current batch of delivery 
products.

• Order Fulfillment Lead Time — The average amount of time, in days, from 
when the supplier role receives an order for the delivery product to when the 
buyer actually receives the product shipment.

The Order Fulfillment Lead Time should be approximately 6 days.

To view delivery product metrics for the Base Manufacturer role:

 Display the properties dialog for the delivery product in the Products pool on 
the Base Manufacturer role detail and view these metrics:

The delivery product of a Distributor or Manufacturer role computes additional 
metrics related to inventory level, which are not relevant for Base Manufacturer 
roles.

See Also Viewing Metrics for Source and Delivery Products in the e-SCOR User? Guide.

Tab Group/Metric

General Order
Quantity to Deliver
Quantity Shipped

Manufacturing Policy
Total Products Accepted
Total Products Rejected

Metrics Metrics
Awaiting Orders
Products On Order
Received Inventory Level
Inventory Level
In Transit Inventory Level
Shipped Inventory Level
Pushed Inventory Level
Manufacturing Batch Size
Order Fulfillment Lead Time
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Viewing Source Product Metrics: Consumer 
Role

The source product of a Consumer role computes:

• Quantity Ordered and Quantity Received — The number of source products 
that have been ordered and received since the start of the simulation.

• Purchase Cost — The average purchase cost for the source product, based on 
the Net Selling Price of each upstream supplier’s delivery product.

• Products On Order — The number of source products for which the source 
planning process has created replenishment orders but which the upstream 
supplier has not yet delivered.

• Received Inventory Level — The number of source products that the buyer 
has received and placed in inventory since the start of the simulation.

• Incoming Inventory Level — The number of source products that the buyer 
has received but not yet placed in inventory.

• Inventory Level — The number of source products currently in inventory.

• Received Fulfillment Time — The average amount of time from when the 
buyer orders source products to when the buyer receives product shipments, 
in days.

The Received Fulfillment Time should be approximately 6 days.

The source product of a Distributor or Manufacturer role computes additional 
metrics related to inventory level, which are not relevant for Consumer roles.
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Saving the Model
To view source product metrics for the Consumer role:

 Display the properties dialog for the source product in the Products pool on 
the Consumer role detail and view these metrics:

See Also Viewing Metrics for Source and Delivery Products in the e-SCOR User? Guide.

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Running the Simulation for the 
Simplest Model

To view Level 2 metrics for the simplest model, you:

• Viewed Source category metrics.

• Viewed ES: Enable Source category metrics.

• Viewed Deliver category metrics.

• Viewed ED: Enable Deliver category metrics.

• Viewed Make category metrics.

• Viewed Plan category metrics.

Tab Group/Metric

General Order
Quantity Ordered
Quantity Received

Sourcing Policy
Purchase Cost

Metrics Metrics
Products On Order
Received Inventory Level
Incoming Inventory Level
Inventory Level
Received Fulfillment Time
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• Viewed delivery product metrics.

• Viewed source product metrics.

You should now know how to view metrics for Level 2 SCOR categories and 
product composites for the simplest e-SCOR model. 

Next, you will create an output report for viewing financial metrics for a role. 
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Creating Output Reports:
Simplest Model
Teaches you how to create and view output metrics in reports.

Introduction 72

Generating Output Report Data 72
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Generating Output Reports in Excel 74

Saving the Model 76

Summary: Creating Reports 76
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Introduction
You can create reports within e-SCOR. You can also send the report data to Excel, 
to CSV files, or to a database, which means you have all the capabilities available 
in these programs to analyze the performance of your model.

For information about sending report data to CSV files, see the ReThink User? 
Guide.

To analyze the performance of the simplest model, you:

• Generate output report data in e-SCOR.

• Generate time-series data in e-SCOR for viewing metrics over time.

• Generate output reports in Excel for further analysis.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-simplest.kb, which shows the 
finished model. To view the Excel report, open the file named Tutorial-
Simplest-Model-Summary-Reports.xls. Follow along in the existing model as 
you read through the exercises.

See Also Writing to and Reading from CSV Files in the e-SCOR User? Guide.

Writing to and Importing from Databases in the e-SCOR User? Guide.

Generating Output Report Data
You can create these types of output reports to view metrics for these objects in 
a model:

• Role Output Report, which includes metrics computed for all Level 1 roles in 
the model.

• Category Output Report, which includes metrics computed for all Level 2 
categories in the model.

• Product Composite Output Report, which includes metrics computed for all 
source and delivery products in the model.

• Resource Output Report, which includes metrics computed for all 
manufacturing resources in the model.

To create an output report, you:

• Create a report object.

• Configure the report object to update at regular time intervals.
70



Generating Output Report Data
• Run the simulation, which generates the report data each time the report 
updates.

You can configure which attributes appear in the report, which you will learn 
how to do this later in this tutorial. You can also configure the time unit for 
computing time-based metrics.

You will now generate output data for a Role Output Report to view financial 
metrics for each role in the model.

Note Remember, you must wait for one or two financial cycles to elapse before the 
model computes financial metrics.

To generate output report data:

1 Display the e-SCOR toolbox, display the Reports palette, select a Role Output 
Report, and place it on the model detail.

Typically, you configure the report object to update at regular time intervals, 
which outputs data each time the report updates. Typically, you also 
configure a report that contains financial data to update once per financial 
period to ensure the report data is always current. 

2 Choose Setup Report as Role Financial Metrics to configure the report to 
include financial metrics only.

3 Display the properties dialog for the Role Output Report, configure the 
Update Mode to be Simulation-Time, and configure the Update Interval to be 
4 weeks and 2 days (30 days).

4 Click the Attributes tab to view the attributes to appear in the report.

You can add and remove attributes to and from the report, as needed. You can 
also configure the column labels. 

5 Choose Show Report to create a report template with the specified metrics.

The report template contains columns for each attribute in the report. 

6 Run the simulation for at least one financial period.

The report contains rows for each role in the model and updates financial data 
once per financial period. 

7 Reset the simulation.

See Also Summary of Input and Output Reports in the e-SCOR User? Guide.

Creating a Report in the e-SCOR User? Guide.

Updating Output Reports at Regular Time Intervals in the e-SCOR User? Guide.

Configuring the Time Unit in the e-SCOR User? Guide.
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Generating Time-Series Data
You might want to compare metric values over time. To do this, you configure the 
report to keep a history. You can configure any type of output report to keep a 
history. The output report timestamps each value in the report.

To generate time-series data:

1 Display the properties dialog for the Role Output Report and enable the 
Keep History option.

When you change the configuration of the report object, you must update the 
report.

2 Choose Update Report on the report object or select the report object and click 
the Update button on the report.

3 Run the simulation again and show the report.

This time, the report contains rows with timestamps for each new value.

4 Reset the simulation.

See Also Keeping a History of Data Values in the e-SCOR User? Guide.

The file contains financial data for all roles in the model.

Generating Output Reports in Excel
You can send report data directly to Excel for further analysis. e-SCOR provides a 
default Excel report with one tab page for each report type. 

When generating reports in Excel, you can configure the Excel macros used to 
format the report. You can also update the report manually and control the 
simulation from Excel.

To generate output reports in Excel:

1 Create a Role Output Report and place it on the model detail.

2 Configure the report object to update once every 30 days of simulation time.

3 From the Start menu, choose Start > Programs > Gensym G2 8.3r0 > Examples 
> G2 e-SCOR > e-SCOR Default Summary Reports to open the default e-SCOR 
summary report in Excel.

The default report is located in the file Default-Summary-Reports.xls, which 
is located in the kbs directory of your e-SCOR product directory. You can also 
open the report directly from Excel.
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Generating Output Reports in Excel
The default report uses a macro to format the report template when you create 
it; therefore, you must enable macros each time you open the report.

4 Click the Enable Macros button in Excel.

Next, Excel attempts to establish a connection to the e-SCOR server.

5 Enter the host and port of the computer on which the e-SCOR server is 
running, using the following syntax:

<host>:<port>

The default value is localhost:1111.

Tip To avoid displaying this dialog each time you open a report, you can create an 
environment variable named ESCOR_SERVER, which defines the host and port 
of the server to which to connect, using the same syntax. 

6 In e-SCOR, choose Show Report on the Role Output Report.

e-SCOR creates a template for the Role Output Report on the appropriate tab 
page in the Excel report. The template contains columns for each metric the 
report computes and rows for each role in the model.

7 In Excel, format the rows and columns of the report to suit your needs.

For example:

• Choose Format > Row > Hide and Format > Column > Hide to hide rows 
and columns whose data you do not need to see.

• Choose Format > Column > Autofit Selection to adjust the column width 
to exactly match the column headers.

• Click a cell and choose Window > Freeze Panes to define column and row 
borders that always remain visible, even when scrolling.

8 Run the simulation.

The report updates financial and asset data once per financial period. 

9 Pause the simulation, then save the Excel report to a new file name, such as 
my-tutorials-Summary-Report.xls.

Note Do not overwrite the Default-Summary-Reports.xls file.

10 Reset the simulation.

See Also Creating Reports in Excel in the e-SCOR User? Guide.
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Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Creating Reports
To create output reports, you:

• Generated output report data.

• Generated time-series data.

• Generate output reports in Excel.

You should know how to create output reports of static and time-series data, 
which update at regular time intervals, both locally in the e-SCOR client and in 
Excel files.

Next, you will look at the underlying processes that e-SCOR runs when you run a 
simulation.
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Introduction
Now that you understand how to create, configure, and run the simplest supply-
chain model, you will create a more realistic model, called the ACME model. This 
model allows you to experiment with different parameter values to analyze 
model performance and perform “what-if” analysis.

The ACME model:

• Manufactures computers from a case and three electronics components, and 
delivers those computers directly to the consumer.

• Sources cases directly from the ACME manufacturer in Taiwan.

• Sources electronic components through a single distributor, which sources 
them directly from another manufacturer.

To configure Level 1 roles for the ACME model, you:

• Set up the model environment.

• Create a product hierarchy, which consists of a computer and two 
components: a case and electronics.

• Configure the supply-chain model, which includes two Base Manufacturer 
roles, a Distributor role, a Manufacturer role, and a Consumer role.

• Assign products to roles so that:

– The Consumer role sources computers.

– The Manufacturer role makes and delivers computers from cases and 
electronics.

– The Distributor role sources and delivers electronics.

– One Base Manufacturer role delivers electronics to the Distributor role.

– The other Base Manufacturer role delivers cases directly to the 
Manufacturer role.

• Configure potential suppliers for each source product in the model.

• Configure resources for the two Base Manufacturer roles and the 
Manufacturer role.
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Introduction
The ACME model makes the following assumptions, which determine the Level 2 
SCOR parameters you must configure:

• Uses a stock/replenishment planning strategy, which means roles source, 
make, and deliver stock products and determine order size, based on source 
planning.

• Uses a pull planning mode, which means downstream buyer roles determine 
when to source products by placing orders, and upstream supplier roles make 
and deliver products, based on those orders.

• Sources each component from a single supplier.

• Delivers a single finished product.

You can also create models that use different inventory control strategies for stock 
products (replenishment, R-Q, and Q), use alternative planning strategies 
(make-to-order and engineer-to-order), source and deliver multiple products that 
you configure separately, source products from multiple suppliers, or use a push 
planning mode. 

See Also Using Stock Planning Strategies.

Using Alternative Planning Strategies.

Configuring Role Details for Multiple Products.

Modeling a Process with Multiple Suppliers.

Using Pull and Push Planning Modes.

All chapters are in the e-SCOR User? Guide.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-acme.kb, which shows the 
finished model. Follow along in the existing model as you read through the 
exercises.
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Configuring the Model Environment: ACME 
Model

First, you must set up the model environment for the ACME model. 

To set up the ACME model environment:

1 Create a new model named ACME.

For details, see Creating a Model.

2 Place a Scenario on the model detail.

For details, see Creating a Scenario.

Configuring the Product Hierarchy: ACME 
Model

In the simplest e-SCOR model, the product hierarchy consists of a single product 
specification, which represents an entire product family. In the ACME model, the 
product hierarchy consists of:

• A computer finished product.

• A case component.

• Three electronics components—mother board, power supply, and drives.

In general, you should try to create the simplest product hierarchy and supply 
chain that models the metrics you are most interested in observing. For example, 
because the Manufacturer role sources the three electronics components from a 
single Distributor role, you can treat them as a single product family that consists 
of three units. 

To configure the product hierarchy:

1 Create a product specification named computer and place it on a Product 
Structure Organizer detail.

For details, see Configuring the Product Specification: Simplest Model.

2 Create a product specification named computer-case and place it on the 
Product Structure detail below the computer.

3 Create a product specification named electronics and place it below the 
computer, next to the computer-case.

4 Choose Create Product Connection on the computer-case and connect the 
stub to the computer.
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Configuring the Supply-Chain Model: ACME Model
5 Choose Create Product Connection on the electronics and connect the stub to 
the computer.

6 Configure the Usage Quantity of the connection between the electronics and 
the computer to be 3 to represent the three electronics components.

The product hierarchy should look similar to this:

See Also Creating a Product Hierarchy with Components in the e-SCOR User? Guide.

Configuring the Supply-Chain Model: ACME 
Model

Once you have created the product hierarchy, you create the supply-chain model 
for the ACME model, which consists of:

• A Base Manufacturer role that delivers cases.

• A Base Manufacturer role that delivers the electronics components.

• A Distributor role that sources and delivers electronics components.

• A Manufacturer role that sources cases and electronics components, and 
makes and delivers computers.

• A Consumer role that sources computers.

The Manufacturer role adds value to the supply-chain by transforming 
components into finished products through a manufacturing step, whereas the 
Distributor role simply delivers its source products directly to the downstream 
buyer. 
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You can also configure a Distributor role to source components and assemble 
those components into finished products, or “kits.” For details, see Modeling a 
Distribution Process in the e-SCOR User? Guide.

Note You must configure each role’s label to be unique.

The ACME model uses the default Financial Period for all roles, 30 days, to 
determine when the role computes financial and asset metrics. It also uses the 
default Financial Payment Terms, also 30 days, to determine when buyer roles 
make payments to supplier roles.

To configure the ACME supply-chain model:

1 Place two Base Manufacturer roles, a Distributor role, a Manufacturer role, 
and a Consumer role on the model detail and configure their labels, as 
follows:

For details, see Creating a Supply-Chain Model: Simplest Model.

2 Select multiple roles, then choose Layout > Align or Distribute and use the 
various menu choices to align and distribute the roles, or use the equivalent 
toolbar buttons located in the toolbar at the top of the window: 

3 Shrink wrap the workspace.
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Assigning Products to Roles: ACME Model
Assigning Products to Roles: ACME Model
Now that you have configured the supply-chain model, you must assign product 
specifications to roles to create source and delivery products for each role, 
as follows:

To assign product specifications to roles for the ACME model:

1 Assign each product specification in the product hierarchy to the appropriate 
role, as outlined in the table above.

2 Verify the assignment of each product specification.

For details, see Assigning Products to Roles: Simplest Model.

Configuring Potential Suppliers: ACME Model
Next, you must assign the potential suppliers for each source product in the 
model, as follows:

Assign this product
specification... To this role... To create...

Computer Case Base Manufacturer Cases A case delivery product.

Electronics Base Manufacturer Electronics An electronics delivery product.

Electronics Electronics Distributor An electronics source and 
delivery product.

Computer Computer Manufacturer A case source product, an 
electronics source product, and a 
computer delivery product.

Computer Consumer A computer source product.

For this source 
product...

Of this role... Assign this role as the 
potential supplier...

Computer Consumer Computer Manufacturer

Electronics Computer 
Manufacturer

Electronics Distributor
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To configure potential suppliers for the ACME model:

1 Show the properties dialog for each source product in the model.

2 Click the Supplier Selection tab and configure the Potential Suppliers 
according to the table above.

Configuring Resources: ACME Model
Each Base Manufacturer and Manufacturer role in the model requires a 
manufacturing resource to make finished products, which determines the number 
of products the role can manufacture in a single batch. By default, each 
Manufacturer role defines a single manufacturing resource, which means the role 
takes the entire build time to manufacture a batch of finished products. You can 
add manufacturing resources and/or configure resource parameters, as needed.

You can configure the Resource Capacity to specify the number of units that each 
manufacturing resource represents, thereby increasing the number of finished 
products a role can manufacture. You can also configure the Efficiency Factor to 
model variation in the build time for different resources. 

These roles in the ACME model require manufacturing resources:

• Base Manufacturer: Cases requires a Cases Plant resource.

• Base Manufacturer: Electronics requires an Electronics Plant resource.

• Computer Manufacturer requires a Computer Plant resource.

In the ACME model, each manufacturing resource uses the default capacity and 
efficiency factor.

To configure resources for the simplest model:

1 Choose Show Resources on each manufacturing role to show the detail of the 
Resources pool. 

2 Show the properties dialog for each resource and configure the Resource 
Label according to the descriptions above.

Notice the Resource Capacity and Efficiency Factor are both 1, the default, which 
means the maximum throughput of the model is 1 times the actual batch size of 

Computer Case Computer 
Manufacturer

Base Manufacturer Cases

Electronics Electronics Distributor Base Manufacturer 
Electronics

For this source 
product...

Of this role... Assign this role as the 
potential supplier...
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Saving the Model
each batch, divided by the Manufacturing Duration. Notice that the resource also 
computes various utilization statistics.

Tip You can display the properties dialog for a resource directly by choosing 
Resources on the role, then choosing the resource to configure.

See Also Configuring Manufacturing Resources in the e-SCOR User? Guide.

Showing Resource Representations for a Role in the e-SCOR User? Guide.

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Configuring Level 1 Roles for the 
ACME Model

To configure Level 1 roles for the ACME model, you:

• Set up the model environment.

• Created a product hierarchy.

• Configured the supply-chain model.

• Assigned products to roles.

• Configured potential suppliers.

• Configured resources.

You should now be able to configure a more complex model, which consists of a 
product hierarchy, a Distributor role and a Manufacturer role, and manufacturing 
resources.
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Introduction
In the simplest model, you configured Level 2 SCOR parameters through the 
properties dialogs for each category and product composite in the model. As you 
build more complex models, you will find that it is easier to configure Level 2 
parameters for categories and product composites by using input reports. Input 
reports enable you to configure parameters for all categories of a given type in a 
single report and to configure parameters for all product composites in the model 
in a single report.

You can create input reports and configure parameters locally in the e-SCOR 
client or in Excel. 

To configure Level 2 SCOR parameters for the ACME model, you:

• Create input reports for configuring category and product composite 
parameters, using the default report templates.

• Configure reports, including visible attributes and filters.

• Configure report data through Excel.

• Configure Level 2 category parameters through an input report.

• Configure product composite parameters through an input report.

• Create output reports for analyzing the performance of the model.

• Configure the simulation to run for a fixed duration.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-acme.kb, which shows the 
finished model. To view the Excel report, open the file named Tutorial-
Simplest-Model-Summary-Reports.xls. Follow along in the existing model as 
you read through the exercises.

Creating Input Reports for Configuring Level 2 
SCOR Parameters

You can create the following types of input reports:

• Role Input Report, which includes parameters for all roles in the model.

• Category Input Report, which includes parameters for all categories in the 
model.

• Resource Input Report, which includes parameters for all manufacturing 
resources in the model.
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Creating Input Reports for Configuring Level 2 SCOR Parameters
• Product Composite Input Report, which includes parameters for all source 
and delivery products in the model.

• Product Specification Input Report, which includes parameters for all product 
specifications in the product hierarchy.

By default, the reports contain the complete set of available parameters for each 
type of object that the report defines. You can filter Level 2 reports to include 
parameters for certain categories only. You can also configure the report to 
include only the parameters you need for your model. For example, you might 
want to create separate reports for configuring Plan, Source, Make, and Delivery 
category parameters. 

The simplest way to do this is to choose from a number of predefined templates. 
For example, to set up a Category Input Report for configuring Source category 
parameters only, you choose the Setup Report as Source Parameters menu choice 
on the report object. The report automatically applies filters to include Source 
category parameters only and configures the appropriate attributes. You can also 
configure the visible attributes and filters manually by configuring the report 
object, as needed.

Now, you will create a number of Category Input Reports for configuring Plan, 
Source, Make, and Deliver category parameters. You will also create a Product 
Composite Input Report for configuring source and delivery product parameters 
in your model. 

To create input reports for configuring Level 2 SCOR parameters:

1 Create four Category Input Reports and a Product Composite Input Report 
from the Reports tab of the e-SCOR toolbar and place them on the model 
detail.

2 Choose one of the following menu choices on each report to set up the report 
to use the default templates:

The report labels update to reflect the name of the template. Each Category 
Input Report is now configured to include only the relevant parameters for 
the specified categories. 

Report Type Menu Choice

Category Input 
Report

Setup Report as Plan Parameters
Setup Report as Source Parameters
Setup Report as Make Parameters
Setup Report as Deliver Parameters

Product Composite
Input Report

Setup Report as Product Parameters
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3 Show the properties dialog for each report and click the Filters and Attributes 
tabs to view the default configuration for each template.

4 Choose Show Report on each report to view the attributes that you can 
configure in each report.

Tip Double-click the divider between the column labels to expand the cell width 
to just fit the attribute names.

To apply values to the model, you configure the parameters in the report and 
click the Apply button.

You can also edit the reports through Excel.

5 In Excel, open the default report named Default-Summary-Reports.xls.

Tip Remember, you can open this report by choosing e-SCOR Default Summary 
Reports from the Start menu.

6 Enable macros and connect to the server.

7 Select all the reports and choose Create from the Reports menu to create 
report templates for each report.

Tip You can select all the reports by selecting individual reports and adding to the 
selection, using the Shift key, or you can select all the reports at once by 
selecting the region.

8 In Excel, click the various tab pages of the reports you created to view the 
default templates.

9 To facilitate viewing, format the reports in Excel, using a combination of these 
techniques:

• Filter rows in the report by clicking the arrow next to the column header 
and choosing the filter value.

For example, to facilitate data entry, click the arrow next to the Block 
column header to display individual categories of the same type. 
Alternatively, click the arrow next to any attribute column header and 
choose NonBlanks to display only those rows that contain values for a 
particular attribute.

• Sort the rows in the report to group similar rows together by choosing 
Data > Sort.

For example, sort the data in the Level 2 Input Report in descending order, 
based on data in the Block column.
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Configuring Reports
• Freeze the column headers and row labels by choosing Window > Freeze 
Panes to facilitate scrolling.

Note Do not filter rows or sort data in an output report until the simulation is 
finished; otherwise, each time the report updates, the data reverts to its 
original configuration.

10 Save the report to the file My-ACME-Summary-Reports.xls.

Configuring Reports
By default, the time unit used for configuring all timing parameters in the report 
is hours. You can configure the time unit to be seconds, minutes, hours, days, or 
weeks, depending on what is most convenient. You can also configure the time 
unit of the report to be none, in which case you configure timing parameters as a 
duration. For example, you would configure 30 days as 4 weeks and 2 days, as 
follows: 004:002:000:000:000.

You can configure the filters applied to the report and the visible attributes that 
appear in the report. By default, the column headers concatenate the 
group/subtable, if any, and the attribute name. For example, in the Product 
Composite Input Report, the demand-order-cycle-time group defines the mean, 
min, mode, and max attributes for configuring different mathematical 
distributions. Thus, the column header for the Demand Order Duration Mean 
attribute looks like this: demand-order-cycle-time.mean. You can edit the column 
labels, if desired. You can also delete attributes from the report, and add attributes 
to the report by choosing from a list of all available attributes.

Caution Each input report contains the UUID internal attribute, which uniquely identifies 
each object’s attribute. Do not remove this attribute from the report; otherwise, 
editing parameter values in the report does not update the model.

To configure the reports:

1 Display the properties dialog for the Plan Parameters report.

Notice that the time unit for the report is hours, the default. 

2 Configure the Time Unit for the Plan Parameters report to be days.

For the Plan Parameters report only, you will configure timing parameters in 
days, rather than hours.

3 Display the properties dialog for the Product Composite Input Reports and 
configure the Time Unit to be none to configure timing parameters, using a 
duration. 
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4 Display the properties dialog for the Deliver Parameters report and click the 
Filters tab.

The report includes data for the relevant categories only. For example, by 
default, the Deliver Parameters report contains data for the D1, D2, and D3 
parameters only. 

5 Disable the D2 and D3 categories for the Deliver Parameters report.

6 Click the Attributes tab.

The report includes only those attributes that are relevant for the specified 
categories. The attribute name appears in the left-hand column, which is the 
default column label for the report. 

The attribute name includes the name of the group/subtable and the attribute, 
for example order-entry-duration-subtable.min, order-entry-duration-subtable.
mode, and order-entry-duration-subtable.max. 

Tip Double-click the divider between the column labels to expand the cell width 
to just fit the attribute names.

You can add and remove attributes from reports, as needed, using the 
buttons.

Particularly for long attribute names, you might want to configure a custom 
column label.

7 Configure the Source Parameters and Make Parameters reports to include 
parameters for the S1 and M1 categories only, respectively.

You are now ready to configure the Level 2 SCOR parameters for the ACME 
model, using the input reports.

See Also Summary of Input and Output Reports in the e-SCOR User? Guide.

Configuring the Attributes to Appear in a Report in the e-SCOR User? Guide.

Filtering Report Data in the e-SCOR User? Guide.
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Configuring Report Data through CSV Files
Configuring Report Data through CSV Files
You can configure report values directly in e-SCOR, or you can configure them 
through CSV files, depending on what is most convenient. Follow these 
instructions if you choose to configure the reports through CSV files.

To configure report data through CSV files:

1 For each Category Input Report, display the properties, click the Excel tab, 
and enable the Excel Report Enabled option.

2 Choose Show Report on each report object to create the CSV file.

e-SCOR creates the file in the Output directory of your e-SCOR installation 
directory.

Configuring Level 2 Category Parameters: 
ACME Model

Level 2 category parameters apply to all products that a role sources, makes, 
and/or delivers. For example, when configuring Source category parameters for 
the Computer Manufacturer role, you configure the time it takes to receive and 
place into inventory both cases and electronics, and the cost of receiving both of 
these components. 

Because a Manufacturer role both sources components and delivers finished 
products, it uses both source and make planning. You must coordinate the timing 
of source and make planning by configuring the initial delays for initiating each 
type of planning. 

Tip In pull planning mode, configure the Initial Plan Delay for the P3: Plan Make 
category to be smaller than the Initial Plan Delay for the P2: Plan Source category. 
That way, make planning occurs before source planning.

To configure Level 2 category parameters for the ACME model:

1 Using the Category Input Report that you created, configure the parameters 
for the Level 2 categories, according to the headings below, using the time 
unit of the report.

Plan Parameters Report

Configure these Plan category parameters in the Plan Parameters report:

• P2 of Electronics Distributor

• P2 of Computer Manufacturer
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• P3 of Computer Manufacturer

• P3 of Base Manufacturer Electronics

• P3 of Base Manufacturer Cases

When configured, the report should look like this:

P2 of Electronics Distributor 

P2 of Computer Manufacturer

P3 of Computer Manufacturer

Parameter Description

Initial Plan Delay = 7
Planning Period = 5

Sends replenishment orders for 
electronics to upstream supplier once 
every 5 days. Uses the default plan delay.

Parameter Description

Initial Plan Delay = 7
Planning Period = 7

Creates the first replenishment order for 
components 7 days into the simulation, 
which happens one day after it creates the 
first build order.

Sends replenishment orders for cases and 
electronics to upstream suppliers once a 
week.

Parameter Description

Initial Plan Delay = 6
Planning Period = 3

Creates the first build order for computers 
6 days into the simulation.

Sends build orders for computers to the 
Make category once every 3 days. 
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P3 of Base Manufacturer Electronics

P3 of Base Manufacturer Cases

2 In Excel, choose Report > Apply from the e-SCOR floating toolbar or press 
Ctrl + A to apply the parameter values to the model.

3 Save the report to the file My-ACME-Summary-Reports.xls.

See Also Applying Input Report Data to the Model from Excel in the e-SCOR User? Guide.

Source Parameters Report

Configure these Source category parameters in the Source Parameters report:

• S1 of Electronics Distributor

• S1 of Computer Manufacturer

• S1 of Consumer

When configured, the report should look like this:

Parameter Description

Initial Plan Delay = 7
Planning Period = 7

Sends build orders for electronics to the 
Make category once a week. Uses the 
default delay.

Parameter Description

Initial Plan Delay = 7
Planning Period = 1

Sends build orders for cases to the Make 
category once a day. Uses the default 
delay.
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S1 of Electronics Distributor

S1 of Computer Manufacturer

Parameter Description

Receiving Cycle Time Duration Subtable.min = 2
Receiving Cycle Time Duration Subtable.mode = 3
Receiving Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
receive electronics.

Verification Cycle Time Duration Subtable.min = 2
Verification Cycle Time Duration Subtable.mode = 3
Verification Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
verify received electronics.

Transfer Cycle Time Duration Subtable.min = 2
Transfer Cycle Time Duration Subtable.mode = 3
Transfer Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
transfer electronics to 
inventory.

Product Receiving Cost.fixed Cost = 5
Product Verification Cost.fixed Cost = 5
Product Transfer Cost.fixed Cost= 5
Create Customer Order Cost.fixed Cost = 5
Invoice Cost.fixed Cost = 5

Costs $5 to receive, verify, 
transfer, create orders, and 
pay invoices for electronics.

Parameter Description

Receiving Cycle Time Duration Subtable.min = 2
Receiving Cycle Time Duration Subtable.mode = 3
Receiving Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
receive components.

Verification Cycle Time Duration Subtable.min = 2
Verification Cycle Time Duration Subtable.mode = 3
Verification Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
verify received components.

Transfer Cycle Time Duration Subtable.min = 2
Transfer Cycle Time Duration Subtable.mode = 3
Transfer Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
transfer components to 
inventory.

Product Receiving Cost.fixed Cost = 2
Product Verification Cost.fixed Cost = 2
Product Transfer Cost.fixed Cost= 2
Create Customer Order Cost.fixed Cost = 2
Invoice Cost.fixed Cost = 2

Costs $2 to receive, verify, 
transfer, create orders, and pay 
invoices for components.
94



Configuring Level 2 Category Parameters: ACME Model
S1 of Consumer

Make Parameters Report

Configure these Make category parameters in the Make Parameters report:

• M1 of Computer Manufacturer

• Mb of Base Manufacturer Electronics

• Mb of Base Manufacturer Computer Cases

When configured, the report should look like this:

Parameter Description

Receiving Cycle Time Duration Subtable.min = 2
Receiving Cycle Time Duration Subtable.mode = 3
Receiving Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
receive components.

Verification Cycle Time Duration Subtable.min = 2
Verification Cycle Time Duration Subtable.mode = 3
Verification Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
verify received components.

Transfer Cycle Time Duration Subtable.min = 2
Transfer Cycle Time Duration Subtable.mode = 3
Transfer Cycle Time Duration Subtable.max = 4

Takes 3 hours, on average, to 
transfer components to 
inventory.

Product Receiving Cost.fixed Cost = 5
Product Verification Cost.fixed Cost = 5
Product Transfer Cost.fixed Cost= 5
Create Customer Order Cost.fixed Cost = 5
Invoice Cost.fixed Cost = 5

Costs $5 to receive, verify, 
transfer, create orders, and pay 
invoices for computers.
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M1 of Computer Manufacturer

Parameter Description

Order Release To Mfg Duration Subtable.min = 2
Order Release To Mfg Duration Subtable.mode = 3
Order Release To Mfg Duration Subtable.max = 4

Starts 
manufacturing 
batches of 
computers 3 hours, 
on average, after 
receiving a build 
order.

Production Material Cycle Duration Subtable.min = 1
Production Material Cycle Duration Subtable.mode = 2
Production Material Cycle Duration Subtable.max = 3

Takes 2 hours, on 
average, to take 
case and electronics 
components out of 
inventory before 
manufacturing 
computers.

Mfg Duration Subtable.min = 7
Mfg Duration Subtable.mode = 8
Mfg Duration Subtable.max = 9

Takes 8 hours, on 
average, to 
manufacture a 
batch of computers.

Move To Delivery Duration Subtable.min = 1
Move To Delivery Duration Subtable.mode = 2
Move To Delivery Duration Subtable.max = 3

Takes 2 hours, on 
average, to transfer 
computers from 
where they are 
manufactured to 
where they are 
delivered.

Production Material Handling Cost.fixed cost = 5 Costs $5 to handle 
raw materials.
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Mb of Base Manufacturer Electronics

Parameter Description

Order Release To Manufacturing Duration Min = 2
Order Release To Manufacturing Duration Mode = 3
Order Release To Manufacturing Duration Max = 4

Starts manufacturing 
batches of electronics 3 
hours, on average, after 
receiving a build order.

Production Material Duration Min = 2
Production Material Duration Mode = 3
Production Material Duration Max = 4

Takes 3 hours, on 
average, to take raw 
materials out of 
inventory before 
manufacturing 
electronics.

Mfg Duration Subtable.min = 3
Mfg Duration Subtable.mode = 4
Mfg Duration Subtable.max = 5

Takes 4 hours, on 
average, to 
manufacture a batch of 
electronics.

Move To Delivery Duration Subtable.min = .5
Move To Delivery Duration Subtable.mode = 1
Move To Delivery Duration Subtable.max = 1.5

Takes 1 hour, on 
average, to transfer 
electronics from where 
they are manufactured 
to where they are 
delivered.

Production Material Handling Cost.fixed cost = 5 Costs $5 to handle raw 
materials.
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Mb of Base Manufacturer Computer Cases 

Parameter Description

Order Release To Mfg Duration Subtable.min = 7
Order Release To Mfg Duration Subtable.mode = 8
Order Release To Mfg Duration Subtable.max = 9

Starts 
manufacturing 
batches of cases 8 
hours, on average, 
after receiving a 
build order.

Production Material Cycle Duration Subtable.min = 7
Production Material Cycle Duration Subtable.mode = 8
Production Material Cycle Duration Subtable.max = 9

Takes 8 hours, on 
average, to take raw 
materials out of 
inventory before 
manufacturing 
cases.

Mfg Duration Subtable.min = 8
Mfg Duration Subtable.mode = 10
Mfg Duration Subtable.max = 12

Takes 10 hours, 
plus or minus 2 
hours, to 
manufacture a 
batch of cases.

Move To Delivery Duration Subtable.min = .5
Move To Delivery Duration Subtable.mode = 1
Move To Delivery Duration Subtable.max = 1.5

Takes 1 hour, on 
average, to transfer 
cases from where 
they are 
manufactured to 
where they are 
delivered.

Production Material Handling Cost.fixed cost = 5 Costs $5 to handle 
raw materials.
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Configuring Level 2 Category Parameters: ACME Model
Deliver Parameters Report

Configure these Deliver category parameters in the Deliver Parameters report:

• D1 of Electronics Distributor

• D1 of Computer Manufacturer

• D1 of Base Manufacturer Electronics

• D1 of Base Manufacturer Cases

When configured, the report should look like this:

D1 of Electronics Distributor

Parameter Description

Order Entry Duration Subtable.min = .5
Order Entry Duration Subtable.mode = 1
Order Entry Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
enter orders for electronics 
components.

Pick Duration Subtable.min = .5
Pick Duration Subtable.mode = 1
Pick Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
pick electronics from inventory 
for delivery.

Packing Duration Subtable.min = .5
Packing Duration Subtable.mode = 1
Packing Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
pack electronics in containers 
for shipment.

Transportation Duration Subtable.min = 24
Transportation Duration Subtable.mode = 48
Transportation Duration Subtable.max = 72

Takes 2 days, on average, to 
ship containers of electronics to 
buyers.

Order Entry Cost.fixed Cost = 2
Order Fulfillment Cost.fixed Cost = 2
Pick Cost.fixed Cost =2
Packing Cost.fixed Cost =2
Transportation Cost.fixed Cost = 5
Invoice Cost.fixed Cost =5
Customer Collections Cost.fixed Cost = 5

Costs $2 to enter, fulfill, pick, 
and pack orders for electronics, 
and costs $5 to transport 
containers, send invoices, and 
collect payments. 
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D1 of Computer Manufacturer

D1 of Base Manufacturer Electronics 

Parameter Description

Order Entry Duration Subtable.min = 7
Order Entry Duration Subtable.mode = 8
Order Entry Duration Subtable.max = 9

Takes 8 hours, on average, to 
enter orders for computers.

Pick Duration Subtable.min = .5
Pick Duration Subtable.mode = 1
Pick Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
pick computers from inventory 
for delivery.

Packing Duration Subtable.min = .5
Packing Duration Subtable.mode = 1
Packing Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
pack computers in containers 
for shipment.

Transportation Duration Subtable.min = 48
Transportation Duration Subtable.mode = 72
Transportation Duration Subtable.max = 96

Takes 3 days, on average, to 
ship containers of computers to 
buyers.

Order Entry Cost.fixed Cost = 5
Order Fulfillment Cost.fixed Cost = 5
Pick Cost.fixed Cost =5
Pack Cost.fixed Cost = 5
Transportation Cost.fixed Cost = 10
Invoice Cost.fixed Cost =10
Customer Collections Cost.fixed Cost = 10

Costs $5 to enter, fulfill, pick, 
and pack orders for computers, 
and costs $10 to transport 
containers, send invoices, and 
collect payments. 

Parameter Description

Order Entry Duration Subtable.min = 3
Order Entry Duration Subtable.mode = 4
Order Entry Duration Subtable.max = 5

Takes 4 hours, on average, to 
enter orders for electronics.

Pick Duration Subtable.min = 1
Pick Duration Subtable.mode = 2
Pick Duration Subtable.max = 3

Takes 2 hours, on average, to 
pick electronics from inventory 
for delivery.

Packing Duration Subtable.min = 1
Packing Duration Subtable.mode = 2
Packing Duration Subtable.max = 3

Takes 2 hours, on average, to 
pack electronics into containers 
for shipment.
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D1 of Base Manufacturer Cases

Transportation Duration Subtable.min = 48
Transportation Duration Subtable.mode = 72
Transportation Duration Subtable.max = 96

Takes 3 days, on average, to 
ship containers of electronics to 
buyers.

Order Entry Cost.fixed Cost = 5
Order Fulfillment Cost.fixed Cost = 5
Pick Cost.fixed Cost = 5
Packing Cost.fixed Cost = 5 
Transportation Cost.fixed Cost = 10
Invoice Cost.fixed Cost =10
Customer Collections Cost.fixed Cost = 10

Costs $5 to enter, fulfill, pick, 
and pack containers for 
electronics, and costs and costs 
$10 to transport containers, 
send invoices, and collect 
payments. 

Parameter Description

Parameter Description

Order Entry Duration Subtable.min = 7
Order Entry Duration Subtable.mode = 8
Order Entry Duration Subtable.max = 9

Takes 8 hours, on average, to 
enter orders for cases.

Pick Duration Subtable.min = .5
Pick Duration Subtable.mode = 1
Pick Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
pick cases from inventory for 
delivery.

Packing Duration Subtable.min = .5
Packing Duration Subtable.mode = 1
Packing Duration Subtable.max = 1.5

Takes 1 hour, on average, to 
pack cases into containers for 
shipment.

Transportation Duration Subtable.min = 96
Transportation Duration Subtable.mode = 168
Transportation Duration Subtable.max = 240

Takes 1 week, plus or minus 3 
days, to ship containers of 
cases to buyers.

Order Entry Cost.fixed Cost = 5
Order Fulfillment Cost.fixed Cost = 5
Pick Cost.fixed Cost =5
Pack Cost.fixed Cost =5
Transportation Cost.fixed Cost = 10
Invoice Cost.fixed Cost =10
Customer Collections Cost.fixed Cost = 10

Costs $5 to enter, fulfill, pick, 
and pack orders for cases, and 
costs $10 to transport 
containers, send invoices, and 
collect payments. 
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Configuring Product Composite Parameters: 
ACME Model

You configure different parameters for different products composites, depending 
on whether it is a source or delivery product, or both. 

Tip To avoid skewed metrics at the beginning of the simulation when a role has not 
yet built up any inventory, configure the Starting Product Inventory Level to be 
the same as the Safety Stock.

To configure product composite parameters for the ACME model:

1 Using the Product Parameters Report that you created, configure the 
parameters for the product composites, according to the headings below.

When configured, the report should look like this (left and right sides):

2 In Excel, choose Report > Apply from the e-SCOR floating toolbar or press 
Ctrl + A to apply the parameter values to the model.

3 Save the report to the file My-ACME-Summary-Reports.xls.
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For details on viewing and configuring Level 2 product composite parameters:

• Configuring Product Composite Parameters.

• Configuring Source Product Parameters: Consumer Role.

• Configuring Delivery Product Parameters: Base Manufacturer.

Electronics Source and Delivery Product: 
Electronics Distributor Role

Parameter Description

Inventory Policy.Starting Product Inventory Level = 200
Inventory Policy.safety Stock = 200
Inventory Policy.minimum Reorder Quantity = 50

Starts with 200 electronics 
components in inventory. 
Replenishes inventory when 
fewer than 200 electronics 
components exist. Creates 
replenishment orders for a 
minimum of 50 electronics 
components at a time.

Suppliers Policy.desired Turnaround = 5 days Wants to receive electronics 
components from suppliers 
within 5 days of placing an 
order. 

Delivery Policy.published Delivery Lead Time = 5 days
Delivery Policy.net Selling Price = 100

Publishes that it can deliver 
electronics components within 
5 days of receiving an order. 
Charges $100 to buyers for 
each electronics component. 
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Computer Delivery Product: Computer 
Manufacturer Role

Electronics Source Product: Computer 
Manufacturer Role

Parameter Description

Inventory Policy.starting Product Inventory Level = 50
Inventory Policy.safety Stock = 50
Inventory Policy.minimum Reorder Quantity = 100

Starts with 50 computers in 
inventory. Replenishes 
inventory when fewer than 50 
computers exist. Creates build 
orders for a minimum of 100 
computers at a time.

Manufacturing Policy.minimum Match Size = 25
Manufacturing Policy.maximum Batch Size = 50
Manufacturing Policy.build Yield = .90

Builds computers in batches 
with a minimum size of 25 
units and a maximum size of 
50 units. Has a 90% 
manufacturing yield. 

Delivery Policy.published Delivery Lead Time = 1 week
Delivery Policy.net Selling Price = 500

Publishes that it can deliver 
computers within 1 week of 
receiving an order. Charges 
$500 to buyers for each 
computer. 

Parameter Description

Inventory Policy.starting Product Inventory Level = 150
Inventory Policy.safety Stock = 150
Inventory Policy.minimum Reorder Quantity = 100

Starts with 150 electronics 
components in inventory, 
which is three times the 
number of cases. Replenishes 
inventory when fewer than 150 
electronics components exist, 
which is three times as many as 
the number of cases. Reorders 
a minimum of 100 electronics 
components at a time.

Suppliers Policy.desired Turnaround = 1 week Wants to receive electronics 
within 7 days of placing an 
order. 
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Computer Case Source Product: Computer 
Manufacturer Role

Electronics Delivery Product: Base Manufacturer 
Electronics Role

Parameter Description

Inventory Policy.starting Product Inventory Level = 50
Inventory Policy.safety Stock = 50
Inventory Policy.minimum Reorder Quantity = 100

Starts with 50 cases in inventory. 
Replenishes inventory when 
fewer than 50 cases exist. 
Reorders a minimum of 100 
cases at a time.

Suppliers Policy.desired Turnaround = 1 week Wants to receive cases within 1 
week of placing an order.

Parameter Description

Inventory Policy.starting Product Inventory Level = 200
Inventory Policy.safety Stock = 200
Inventory Policy.minimum Reorder Quantity = 50

Starts with 200 electronics 
components in inventory. 
Replenishes inventory when 
fewer than 200 electronics 
components exist. Creates 
build orders for a minimum of 
50 electronics components at a 
time.

Manufacturing Policy.minimum Batch Size = 25
Manufacturing Policy.maximum Batch Size = 50
Manufacturing Policy.build Yield = .80

Builds electronics in batches 
with a minimum size of 25 
units and a maximum size of 
50 units. Has an 80% 
manufacturing yield. 

Delivery Policy.published Delivery Lead Time = 1 day
Delivery Policy.net Selling Price = 50

Publishes that it can deliver 
electronics components within 
1 day of receiving an order. 
Charges $50 to buyers for each 
electronics component. 
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Computer Source Product: Consumer Role

Computer Case Delivery Product: Base 
Manufacturer Computer Cases Role

Parameter Description

Demand Order Cycle Time.mean = 1 week Places an order once a week.

Demand Order Size.min = 20
Demand Order Size.mode = 25
Demand Order Size.max = 30

Places orders for 25 computers, 
plus or minus 5.

Suppliers Policy.desired Turnaround = 1 week Wants to receive computers 
within 1 week of placing an 
order. 

Parameter Description

Inventory Policy.starting Product Inventory Level = 200
Inventory Policy.safety Stock = 200
Inventory Policy.minimum Reorder Quantity = 100

Starts with 200 cases in 
inventory. Replenishes 
inventory when fewer than 200 
cases exist. Creates build 
orders for a minimum of 100 
cases at a time.

Manufacturing Policy.minimum Batch Size = 250
Manufacturing Policy.maximum Batch Size = 500
Manufacturing Policy.build Yield = .95

Builds electronics in batches 
with a minimum size of 250 
units and a maximum size of 
500 units. Has a 95% 
manufacturing yield. 

Delivery Policy.published Delivery Lead Time = 1 week
Delivery Policy.net Selling Price = 10

Publishes that it can deliver 
cases within 1 week of 
receiving an order. Charges 
$10 to buyers for each case. 
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Creating Output Reports: ACME Model
The last step in configuring the ACME model is to create the following output 
reports to analyze the performance of the model:

• Role Financial Metrics Report

• Role Assets Metrics Report

• Enable Source Metrics Report

• Enable Deliver Metrics Report

• Plan Metrics Report

• Source Metrics Report

• Make Metrics Report

• Deliver Metrics Report

• Product Inventory Metrics Report

• Product Metrics Report

You will create these reports by using the default report templates for the Role 
Output, Category Output, and Product Composite Output Reports. 

The Role Output Reports update once per financial period, and the Category 
Output Report and Product Composite Output Report update once a week.

To create output reports for the ACME model:

1 Create a Role Output Report, configure the Update Mode to be Simulation 
Time, and configure the Update Interval so that it updates once per financial 
period, which is 30 days.

2 Clone the object to create two more reports, then choose one of the following 
menu choices on each report object:

• Setup Report as Role Financial Metrics

• Setup Report as Role Asset Metrics

3 Create a Category Output Report, configure it to update once per week of 
simulation time, clone the object to create a total of six reports, then choose 
one of the following menu choices on each report object:

• Setup Report as Enable Source Metrics

• Setup Report as Enable Deliver Metrics

• Setup Report as Plan Metrics

• Setup Report as Source Metrics
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• Setup Report as Make Metrics

• Setup Report as Deliver Metrics

4 Create a Product Composite Output Report, configure it to update once per 
week of simulation time, clone the object to create two reports, then choose 
one of the following menu choices on each report object:

• Setup Report as Product Inventory Metrics

• Setup Report as Product Metrics

Configuring the Simulation to Run for a Fixed 
Duration

Typically, you run a simulation for a fixed duration so you can compare the 
performance of different sets of input parameters over the same duration. To do 
this, you configure the duration of the Scenario associated with the model. 
Typically, you configure the Scenario to run for several financial periods. 

Tip To ensure that the simulation generates data for the last financial period, 
configure the duration of the Scenario to be one day more than the end of the last 
financial period. For example, to run the simulation for two financial periods of 30 
days each, configure the Scenario to run for 61 days.

To configure the simulation to run for a fixed duration:

1 Display the properties dialog for the Scenario on the model detail.

2 On the Scenario tab, configure the Duration to be 8 weeks and 5 days 
(61 days).

Now, when you run the simulation, it will run for two financial cycles plus one 
day, then stop.

Saving the Model
Save the model to your project name.

For details, see Saving a Model.
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Summary: Configuring Level 2 SCOR for the ACME Model
Summary: Configuring Level 2 SCOR for the 
ACME Model

To configure Level 2 SCOR parameters for the ACME model, you:

• Created input reports.

• Configured reports.

• Configured report data through CSV files

• Configured Level 2 category parameters.

• Configured product composite parameters.

• Created output reports.

• Configured the simulation to run for a fixed duration.

You should now know how to configure Level 2 SCOR parameters for categories 
and product composites through an input report. You are now ready to run the 
simulation.
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Introduction
When you run the simulation for the ACME model, you will determine model 
performance by asking a series of questions about key performance metrics, 
under two different scenarios:

• Normal demand, where the customer orders an average of 25 computers a 
week.

• Increased demand, where the customer orders an average of 50 computers a 
week.

You will experiment with modifying key parameters to improve the performance 
of the model under the scenario of increased demand.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-acme.kb, which shows the 
finished model. To view the Excel report, open the file named Tutorial-ACME-
Summary-Reports.xls. Follow along in the existing model as you read through 
the exercises.

Running the Simulation: Normal Demand
You will now run the simulation to determine how the Manufacturer role 
performs under a situation of normal demand.

To run the ACME model simulation under a scenario of normal demand:

1 Start the ACME model simulation running.

After the first financial period, e-SCOR updates the Role Financial Metrics and 
Role Asset Metrics Reports. 

2 Observe the metrics as the model runs.

You can view the metrics through the Metrics toolbar, the dialogs, or the 
reports, depending on what you find most convenient. 

The simulation stops after 61 days of simulation time has passed.

3 To analyze the performance of the model, ask yourself the following 
questions, using the hints to help you decide which metrics to look at:

• How much money did the manufacturer receive during the two financial 
periods? How much money did it receive in the current financial period? 
How do these values compare with the money the consumer paid? Are 
there any discrepancies? If so, why?

Hint: Look at the Manufacturer role’s Financial Collections and compare it 
with the Consumer role’s Financial Payments, both the total value and 
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Running the Simulation: Normal Demand
within the current financial the period. Discrepancies exist when the 
Manufacturer role has Financial Bookings or Financial Outstanding, and 
when the Consumer role has Financial Obligations. In this case, the sum of 
the Manufacturer role’s Financial Collections Total, Financial Bookings, 
and Financial Outstanding should equal the sum of the Consumer role’s 
Financial Payments Total and Financial Obligations.

• What is the carrying cost of the manufacturer’s inventory after two 
financial periods? How much of that cost is for finished computers? What 
is the cost basis for the inventory?

Hint: Look at the Inventory Days of Supply for the Manufacturer role and 
compare this value with the Finished Goods Days of Supply. The days of 
supply metrics are cost-weighted values of the current inventory, based 
on the Net Selling Price of the Manufacturer role’s computer delivery 
product.

• What is the carrying cost in days for the manufacturer’s inventory turn-
over? Is the manufacturer taking in more money than it is spending, or 
vice versa? How much? What is the value of computer sales for the 
current financial period? How much money does the manufacturer have 
available during the current financial period? 

Hint: Asset Turns indicates how long it takes to turn over inventory, 
measured as a cost-weighted value, in days. 

Cash-to-Cash Cycle Time indicates whether the role takes in more money 
than it spends or vice versa, during the current financial period, measured 
as a cost-weighted value. A positive value means the role spends more 
money than it takes in, and a negative value indicates the role takes in 
more money than it spends. 

Days Sales Outstanding indicates the value of sales for the current 
financial period, measured in days, which is the sum of Financial 
Collections, Financial Bookings, and Financial Outstanding. 

Cash Flow Period indicates the amount of money available during the 
current financial period, which is equal to the Financial Collections within 
Financial Period minus the Financial Payment within Financial Period.

• What is the manufacturer’s total cost of doing business? How do you 
account for all of these costs?

Hint: Look at the Order Management Costs for the Manufacturer role and 
compare this value with the sum of the Cost Incurred metrics for the 
Source and Deliver categories on the role detail. These values should be 
the same, except that Order Management Costs does not include the 
Receiving Cost or the Invoice Cost of the Source category, as defined by 
SCOR. Note that Order Management Costs do not include the Production 
Material Handling Cost of the Make category either.
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• What percentage of time does the customer receive shipments on or before 
the requested date? How does this compare with the percentage of time 
the manufacturer delivers shipments on or before the customer request 
date? What is the current vs. average value of these metrics?

Hint: Look at the Supplier On-Time Performance for the Consumer role’s 
ES: Enable Source category, which computes the percentage of time that 
the role receives shipments within the Desired Turnaround of its source 
product. Compare this value with the Delivery Performance and Perfect 
Order Fulfillment for the Manufacturer role’s ED: Enable Deliver 
category. These values should all be the same. Click the button next to 
each of these metrics in the dialogs to show the current and average 
values.

In the ACME model, Delivery Performance is the same as Perfect Order 
Fulfillment, because the Consumer role accepts only complete shipments. 
If the Consumer role allowed partial shipments, Perfect Order Fulfillment 
would be the percentage of time that the role delivers shipments before 
the customer request date and in the requested amounts. 

You can also look at Fill Rates for the Manufacturer role’s Deliver 
category, which measures the percentage of product shipments that the 
role delivers within 24 hours of receiving an order. 

• On average, how late or early are the shipments of computers that the 
customer receives?

Hint: Look at the Product Shipments Lead Time of the S1: Source Stocked 
Products category on the Consumer role detail. A positive number 
indicates the average amount of time that shipments are early, and a 
negative number indicates the average amount of time that shipments are 
late. The delta is measured against the Desired Turnaround of the 
Consumer role’s computer source product. 

• How much time, on average, does it take the manufacturer to make a 
batch of computers, from when it receives a build order to when it releases 
computers for shipment? What factors contribute to this time?

Hint: Look at the Make Cycle Time for the Manufacturer role’s Make 
category. The timing parameters for the Make category all contribute to 
the cycle time.

• How much time, on average, does it take the manufacturer to fulfill orders 
for computers? How does this time compare with the average amount of 
time it takes the customer to receive computer shipments? How do these 
values compare with the desired turnaround time?

Hint: Look at the Order Fulfillment Lead Time of the Manufacturer role’s 
computer delivery product. Compare this value with the Received 
Fulfillment Time of the Consumer role’s computer source product. These 
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Running the Simulation: Normal Demand
values should be the same. Compare these values with the Desired 
Turnaround Time of the Consumer role’s computer source product.

• How many components and finished products does the manufacturer 
have in inventory at the end of the simulation? How does this compare 
with the amount of safety stock the role wants to keep in inventory?

Hint: Look at the Inventory Level of the source and delivery products for 
the Manufacturer role. The higher the inventory levels are above the 
Safety Stock, the more excess inventory the role is carrying.

• How many computers has the manufacturer received orders for and how 
many computers has it actually shipped? How does this compare with the 
number of computers the customer has ordered and the number of 
computers it has received? Are there any discrepancies? If so, why?

Hint: Look at the Quantity to Deliver and Quantity Shipped of the 
Manufacturer role’s computer delivery product. Compare these values 
with the Quantity Ordered and Quantity Received of the Consumer role’s 
computer source product. If the Consumer role has received every 
shipment, these values will the same. If the values are not the same, look 
at the In Transit Inventory Level of the Manufacturer role’s computer 
delivery product and the Products on Order of the Consumer role’s 
computer source product. These values should be the same and should 
make up the difference between actual orders received and shipped.

• How many orders for computers has the consumer placed with the 
manufacturer? How does this compare with the number of orders the 
manufacturer has received and shipped? 

Hint: Look at the Orders Sent and Product Shipments Received for the 
ES: Enable Source category of the Consumer role. Compare this with the 
Orders Received and Products Shipments Sent for the ED: Enable Deliver 
category of the Manufacturer role. These values should be the same.

• How many computers did the manufacturer have to discard as scrap 
compared with the number it actually could use? 

Hint: Look at the Total Products Accepted and Total Products Rejected for 
the Manufacturer role’s computer delivery product. The model computes 
these values based on the Build Yield for the Manufacturer role’s 
computer delivery product. 

4 Save the report to the file named My-ACME-Summary-Reports.xls.
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Running the Simulation: Increased Demand
Now, you will increase the number of computers the Consumer role orders and 
run the simulation again to determine performance. You will then experiment 
with modifying various parameters to improve performance under the scenario 
of increased demand.

To run the ACME model simulation under a scenario of increased demand:

1 Increase the average number of computers the Consumer role orders to 100.

To do this, configure the Demand Order Size parameters for the computer 
source product of the Consumer role through the dialogs or through the 
Product Parameters report, as follows:

2 Run the simulation again until it stops.

3 What effect does the increased demand have on performance and where are 
these effects the most pronounced?

4 Experiment with configuring one or more of the following parameters to 
improve performance:

• Increase the frequency with which the manufacturer sends build orders to 
manufacturing for computers and sends replenishment orders to its 
suppliers for components.

Hint: Decrease the Planning Period of the P3: Plan Make and P2: Plan 
Source categories.

• Increase the level at which the manufacturer replaces its inventory of 
computers, cases, and electronics.

Hint: Increase the Safety Stock for the computer delivery product and the 
electronics and case source products. Remember that the safety stock for 
electronics should be three times the safety stock for cases, because a 
computer requires three electronics components for every case.

• Increase the number of computers the manufacturer can make in a single 
batch.

Hint: Increase the Maximum Batch Size for the Manufacturer role’s 
delivery product.

Parameter Value

Demand Order Size.min 25

Demand Order Size.max 75

Demand Order Size.mode 50
116



Running the Simulation: Increased Demand
• Increase the number of available manufacturing resources.

Hint: Configure the Resource Capacity of the Computer Plant resource 
from 1 to 2, or create another resource and assign it to the Manufacturer 
role.

• Decrease the amount of time it takes to deliver shipments of computers to 
customers.

Hint: Decrease the Transportation Duration of the Manufacturer role’s 
Deliver category.

You should be able to achieve approximately an average of 75% on-time 
performance with the following values for the Manufacturer role: 

5 Save the report to the file name called My-ACME-Summary-Reports.xls.

Object Parameter Value

P3 Planning Period 1 day

P2 Planning Period 3 days

Computer
(delivery 
product)

Starting Product Inventory Level 100

Safety Stock 100

Minimum Batch Size 100

Maximum Batch Size 150

Electronics
(source 
product)

Starting Product Inventory Level 300

Safety Stock 300

Case
(source 
product)

Starting Product Inventory Level 100

Safety Stock 100

Computer
Manufacturer
resource

Resource Capacity 2

D1 Transportation Duration Min = 1
Mode = 2
Max = 3
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Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Running the ACME Model 
Simulation

To run the simulation for the ACME model, you ran two scenarios:

• Normal demand.

• Increased demand.

You should now have a better understanding of how some of the key input 
parameters impact some of the key metrics in the model.

In the last model, you will focus on optimizing on-time performance, inventory 
levels, and inventory days of supply by varying customer demand, delivery 
times, and safety stocks.
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11
Case Study:
Central Distributor Model
Provides a case study of a central distribution process that lets you experiment 
with determining optimal inventory replenishment levels and implementing a 
vendor-managed inventory control system.
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Introduction
In this part of the tutorial, we present a case study that addresses a real-world 
business problem. First, you will model a central pharmaceutical distribution 
process with three distribution sites, then you will perform “what-if” analysis to 
answer these two questions:

• How much inventory does the central distributor need to carry to guarantee 
that the downstream consumers never runs out of inventory?

• What effect would implementing a vendor-managed inventory (VMI) system 
have on the distributor’s inventory levels and associated carrying costs?

The case study describes the:

• Business problem.

• Supply chain.

• Input parameters.

• Output metrics.

To implement the case study, you:

• Configure the supply-chain model.

• Configure the Level 2 SCOR parameters by mapping the inputs and outputs 
to e-SCOR parameters and metrics, then create input and output reports for 
configuring and viewing values.

• Configure the simulation to run for a fixed duration.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-vmi.kb, which shows the finished 
model. To view the Excel report, open the file named Tutorial-VMI-Summary-
Reports.xls. Follow along in the existing model as you read through the 
exercises.

Case Study: Business Problem
A regional supplier of medical supplies and drugs is trying to convince its 
customers that it can save them money by taking ownership of their stock and 
managing their resupply. The Just-in-time Medical Supplies (JMS) Co. wants to 
show three customers, the Saint Augustine Hospital, Bearly Legal Drugs, and 
Cold Storage Nursing Home, how much it can reduce inventory and associated 
costs while maintaining adequate safety stock at each location. JMS also wants to 
know how much it can reduce its own inventory if it can deliver supplies to them 
more often.
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Case Study: Supply Chain
JMS must show its customers the minimum inventory everyone must carry to 
meet their normal and worst case scenarios. Senior management wants this 
information in terms of days of supply and other standard asset calculations.

If JMS were to take over control of the customer's stock, they think that they could 
cut normal delivery time in half due to simpler delivery schedules. They need to 
determine what effect this strategy would have on their assets.

Case Study: Supply Chain
The pharmaceutical distributor has three customers, which are themselves 
distribution sites that deliver pharmaceuticals and medical supplies to their 
customers, as follows:

• Site A is a hospital, which delivers supplies to its patients.

• Site B is a nursing home, which delivers supplies to its residents.

• Site C is a pharmacy, which delivers supplies to its customers.

The central distributor receives its inventory directly from a manufacturer.

The supply chain looks like this:

Case Study: Input Parameters
The central distributor case study deals strictly with inventory levels, days of 
supply, and delivery times. Therefore, the only input parameters you need to 
configure are those related to:

• Order quantity and frequency

• Planning

• Selling price

• Delivery times

Central
Distributor

Site A

Site B

Site C

Consumer A

Consumer B

Consumer C

Manufacturer
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Order Quantity and Frequency

Each consumer places an order with each distribution site once a day and in these 
quantities with this amount of variation, based on a triangular distribution:

Planning

Once a week, each distribution site and the central distributor determine how 
many orders to place with their suppliers. The manufacturer determines how 
many build orders to send to manufacturing to fulfill its orders once a week as 
well.

To receive volume discounts, each process role in the supply chain uses the 
following minimum order sizes when placing orders with suppliers:

Because of the nature of the products being shipped, each distribution site must 
maintain sufficient inventory to ensure that it never runs out. To do this, you 
must determine the optimal inventory level that the central distributor and each 
distribution site must maintain before replenishing.

The manufacturer replenishes its inventory of finished goods whenever it’s safety 
stock goes below 6000 units, regardless of the size of the orders it receives.

Each role starts the simulation with as much initial inventory of its source and 
delivery products as the safety stock you specify.

Each role accepts partial shipments. 

Quantity Consumer A Consumer B Consumer C

Order Size Minimum 50 100 100

Order Size Mode 100 200 100

Order Size Maximum 150 400 100

Distribution Sites Central Distributor Base Manufacturer

500 units 1000 units 5000 units
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Case Study: Output Metrics
Selling Price

To compute days of supply from inventory levels, you need to know how much 
each buyer pays for its inventory. In this case study, assume:

• The manufacturer’s selling price to the central distributor is $5.

• The central distributor’s selling price to the distribution sites is $10.

• The distribution sites’ selling price to their consumers is $15.

Delivery Time

The central distributor delivers orders at 8:00 AM each day. Each delivery takes 
between six and nine days. This variation in delivery time requires that each 
distribution site keep enough inventory on hand at all times to ensure that they 
never run out.

Each process role in the supply chain delivers shipments to its downstream 
buyers according to these frequencies, based on a triangular distribution:

Case Study: Output Metrics
Due to the nature of the products being shipped, the central distributor must 
ensure that the end consumers in the supply chain never run out of inventory. To 
do this, it must ensure that the on-time performance of each consumer is as close 
to 100% as possible.

To do this, you will attempt to optimize inventory levels for each of the three 
distribution sites, as well as for the central distributor, by maintaining the 
smallest possible inventory, while never running out.

In addition, you need to determine the dollar value of your inventory, in terms of 
days of supply, as well as other asset calculations such as asset turns, cycle time, 
and cash flow.

Delivery Time
Base
Manufacturer

Central 
Distributor

Distribution
Sites

Minimum 2 weeks 6 days 30 minutes

Mode 2 weeks 7.5 days 30 minutes

Maximum 2 weeks 9 days 30 minutes
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Configuring the Supply Chain: Central 
Distributor Model

The supply-chain model consists of these process roles:

Each role in the supply chain sources, makes, and/or delivers pharmaceutical 
products, as appropriate for the role. Because this case study is concerned with 
overall inventory levels of all products, rather than inventory levels of particular 
products, the product hierarchy consists of a single product specification.

To configure the supply-chain model:

1 On the Getting Started workspace, create a model named Central Distributor.

For details, see Configuring the Model Environment.

2 Create a single product specification named Products, which represents the 
pharmaceutical products and medical supplies.

For details, see Configuring the Product Specification: Simplest Model.

3 Create roles to form the supply chain.

For details, see Configuring the Supply-Chain Model: ACME Model.

4 Assign the product specification to each role in the supply-chain model.

For details, see Assigning Products to Roles: Simplest Model.

5 Configure the basic parameters for each role.

For details, see Configuring Role Parameters: Simplest Model.

6 Configure the Financial Period of each role to be 2 weeks.

For details, see Configuring Role Parameters: Simplest Model.

Role Labels Description

Base Manufacturer The Base Manufacturer role that supplies the 
central pharmaceutical distributor.

Central Distributor The central pharmaceutical Distributor role.

Site A
Site B
Site C

The three Distributor roles that buy from the 
central distributor.

Consumer A
Consumer B
Consumer C

The three Consumer roles that consume the 
pharmaceuticals and medical supplies that 
each site delivers.
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Configuring Level 2 SCOR: Central Distributor Model
7 Configure resources for the manufacturer that supplies the central distributor.

For details, see Configuring Resources: ACME Model.

The model should look something like this:

Configuring Level 2 SCOR: Central Distributor 
Model

The supply-chain model consists of eight roles, whose Level 2 SCOR parameters 
you must configure. This case study is focused on determining optimal inventory 
levels, given perfect on-time performance. Therefore, you will configure only 
those parameters that affect inventory and on-time performance. 

To configure Level 2 SCOR for the central distributor model, you:

• View a diagram of key inputs and outputs for the central distributor model.

• Map the inputs and outputs to the appropriate e-SCOR parameters and 
metrics for each of these roles:

– Consumer roles

– Distributor roles

– Base Manufacturer role

• Create input reports for configuring the key parameters.

• Configure Level 2 SCOR parameters through the input reports.

• Create output reports for viewing the key metrics.
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• Configure the simulation to run for a fixed duration.

Diagram of Key Inputs and Outputs

This diagram shows the key inputs (above each role) and outputs (below each 
role) that you need to configure and measure for each role:

Central
Distributor

Site A

Site B

Site C

Consumer A

Consumer B

Consumer C

order frequency
safety stock
delivery time
selling price

order frequency
safety stock
delivery time
selling price

order frequency
safety stock
delivery time

order size
order frequency

inventory level
inventory days of supply

assets

inventory level
inventory days of supply

assets

on-time performance

Manufacturer
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Configuring Level 2 SCOR: Central Distributor Model
Mapping Inputs and Outputs for Consumer Roles

You specify the size and frequency with which each Consumer role places orders 
with each distribution site by configuring parameters in the source product for 
each Consumer role.

You view on-time performance in the ES: Enable Source category on the 
Consumer role detail.

This table maps the inputs and output for the Consumer roles to the appropriate 
e-SCOR parameters and metric, assuming a triangular distribution for the 
parameters, the default:

Mapping Inputs and Outputs for Distributor Roles

A Distributor role uses source planning to determine the size and frequency with 
which it places orders with suppliers. You configure source planning parameters 
in the P2: Plan Source category on the role detail and in the source and delivery 
products associated with the role. 

You determine delivery time by configuring parameters in the Deliver category 
on each role detail.

The model computes inventory levels, based on products shipped and received. 
Inventory days of supply and other asset calculations represents the dollar value 
of the current inventory level, measured in days. Therefore, to translate current 
inventory levels into a dollar amount, you must provide a value for the price each 
downstream buyer must pay for its source products. To do this, you configure the 
Net Selling Price parameter of each supplier’s delivery product. The buyer then 
computes the Purchase Cost metric for its source product. 

Description
Input/
Output

Category/
Product Composite

 
Parameter/Metric

Order size I Source product
(Demand tab)

Demand Order Size
Min
Mode
Max

Order frequency I Source product 
(Demand tab)

Demand Order Duration
Min
Mode
Max

On-time
performance

O ES: Enable Source
(Enable Source tab)

Supplier On-Time
Performance (%)
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This table maps the inputs and outputs for the Distributor roles to the appropriate 
e-SCOR parameters and metrics, assuming a triangular distribution for the timing 
parameters, the default:

Mapping Inputs for Base Manufacturer Role

A Base Manufacturer role uses make planning to determine the size and 
frequency with which it creates and sends build orders to manufacturing. You 
configure make planning parameters in the P3: Plan Make category and in the 
delivery product associated with the role. 

Similar to the Distributor roles, you must configure the Net Selling Price of the 
delivery product so the downstream central distributor can compute Inventory 
Days of Supply.

Description
Input/
Output

Category/
Product Composite

 
Parameter/Metric

Order 
frequency

I P2: Plan Source Planning Period

Safety stock I Source and delivery
product
(Inventory tab)

Safety Stock

Delivery time I D1: Deliver Stock
Product
(Transportation tab)

Transportation 
Duration

Min
Mode
Max

Inventory I Delivery product
(Delivery tab)

Net Selling Price

O Source and delivery
product
(Metrics tab)

Inventory Level

O Distributor role
(Assets tab)

Inventory 
Days of Supply

Assets O Distributor role
(Asset tab)

Asset Turns

Cash-to-Cash 
Cycle Time

Cash Flow Period
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Configuring Level 2 SCOR: Central Distributor Model
This table maps the inputs for the Base Manufacturer role to the appropriate 
e-SCOR parameters, assuming a triangular distribution for timing parameters, the 
default:

Creating Input Reports for Configuring Key 
Parameters

You will create the following input reports for configuring the key Level 2 SCOR 
parameters:

• Category Input Report, which will contain parameters relating to planning 
and delivery time.

• Product Composite Input Report, which will contain parameters relating to 
orders quantity and frequency, product cost, and starting inventory.

Tip Remember, you must include the UUID parameter in all input reports, which 
provides a unique identifier for each row in the spreadsheet.

This table summarizes the internal attribute groups and names that should 
appear in each input report:

Description
Input/
Output

Category/
Product Composite

 
Parameter/Metric

Order 
frequency

I P3: Plan Make Planning Period 

Safety stock I Delivery product
(Inventory tab)

Safety Stock

Delivery time I D1: Delivery Stock
Product
(Transportation tab)

Transportation 
Duration

Min
Mode
Max

Inventory I Delivery product
(Delivery tab)

Net Selling Price

Report Attribute Group Attribute Name

Plan Parameters N/A Role Label

N/A Planning Period
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To create input reports for configuring key parameters:

1 Create two Category Input Reports from the Reports tab on the e-SCOR 
toolbar and place them on the model detail.

2 Choose Setup Report as Plan Parameters on one report and Setup Report as 
Deliver Parameters on the other report.

3 Click the Attributes tab and configure the attributes that should appear in the 
report, according to the table above.

For details, see Creating Input Reports for Configuring Level 2 SCOR 
Parameters.

4 Configure the Time Unit of the Plan Parameters and Deliver Parameters 
reports to be weeks and days, respectively.

5 Open the e-SCOR Default Summary Reports in Excel.

Deliver 
Parameters

N/A Role Label

Transportation 
Duration

Min
Mode
Max

Product 
Composite 
Input Report

N/A Product Name

N/A Role Label

N/A Is Source Product

N/A Is Delivery Product

Demand Order 
Duration

Min
Mode
Max

Demand Order Size Min
Mode
Max

Inventory Policy Starting Product Inventory 
Inventory

Inventory Policy Safety Stock

Inventory Policy Minimum Reorder Quantity

Delivery Policy Net Selling Price

Report Attribute Group Attribute Name
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Configuring Level 2 SCOR: Central Distributor Model
6 Choose Show Report on the Category Input Report to create the report 
template in Excel.

7 Configure the spreadsheet to facilitate viewing.

Tip Hide the ES, ED, S1, and Mb categories so the spreadsheet includes only the 
S1, P2, P3, and D1 categories.

For details, see Creating Input Reports for Configuring Level 2 SCOR 
Parameters.

8 Create a Product Composite Input Report and configure the attributes to 
appear, according to the table above.

9 Configure the Time Unit of the Product Composite Input Report to be days.

10 Choose Show Report on the Product Composite Input Report to create the 
report template in Excel.

Configuring Level 2 SCOR: Central Distributor 
Model

You can now configure the key Level 2 SCOR parameters for all relevant 
categories and product composites in the model through the input reports.

Based on the description in Case Study: Input Parameters, configure the following 
category parameter values through the Level 2 Input Report. Be sure to enter all 
time-based values in the time unit of the report.

Category Role Label Parameter Name Value

P3 Base 
Manufacturer

Planning Period 1 week

P2 Central 
Distributor

Planning Period 1 week

P2 Site A
Site B
Site C

Planning Period 1 week

D1 Central 
Distributor

Transportation Duration.min
Transportation Duration.mode
Transportation Duration.max

6 days
7.5 days
9 days
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Similarly, configure these product composite parameter values for these roles 
through the Product Composite Input Report, using the time unit of the report.

D1 Base 
Manufacturer

Transportation Duration.min
Transportation Duration.mode
Transportation Duration.max

14 days
14 days
14 days

D1 Site A
Site B
Site C

Transportation Duration.min
Transportation Duration.mode
Transportation Duration.max

.042 days

.042 days

.042 days

Category Role Label Parameter Name Value

Role Label Parameter Name Value

A Consumers Demand Order Duration.min
Demand Order Duration.mode
Demand Order Duration.max

1 day
1 day
1 day

Demand Order Size.min
Demand Order Size.mode
Demand Order Size.max

50
100
150

B Consumers Demand Order Duration.min
Demand Order Duration.mode
Demand Order Duration.max

1 day
1 day
1 day

Demand Order Size.min
Demand Order Size.mode
Demand Order Size.max

100
200
400

C Consumers Demand Order Duration.min
Demand Order Duration.mode
Demand Order Duration.max

1 day
1 day
1 day

Demand Order Size.min
Demand Order Size.mode
Demand Order Size.max

100
100
100

Site A
Site B
Site C

Net Selling Price 15

Minimum Reorder Quantity 500

Central Distributor Net Selling Price 10

Minimum Reorder Quantity 1000
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Configuring Level 2 SCOR: Central Distributor Model
Note You will configure the Safety Stock and Starting Product Inventory Level for the 
product composites of each Distributor role later, based on estimates, when you 
run the simulation.

To configure Level 2 SCOR parameters:

1 In Excel, display the appropriate spreadsheet by clicking the tab at the bottom.

2 Enter values into the appropriate cells, according to the tables above.

3 When you are finished entering values in the spreadsheet, choose Reports > 
Apply from the e-SCOR floating toolbar or press Ctrl + A to apply the values 
to the model.

The values you entered into the spreadsheet now exist in the appropriate 
locations in the e-SCOR dialogs.

Creating Output Reports for Viewing Key Metrics

You will create two output reports for viewing key parameters:

• Category Output Report, which will contain the supplier on-time 
performance metric for the ES: Enable Source category of each Consumer role.

• Role Output Report, which will include the asset metrics for each role.

This table summarizes the attributes that should appear in each output report:

Base Manufacturer Starting Product Inventory Level 5000

Net Selling Price 5

Safety Stock 15000

Minimum Reorder Quantity 5000

Role Label Parameter Name Value

Report Attribute Name

Category Output Report Role Label

Supplier On-Time Delivery Performance.average 
Value

Role Output Report Label

Inventory Days of Supply.average Value
133



You will configure the reports to update at regular time intervals, based on 
simulation time.

To create output reports for viewing key metrics:

1 Create a Category Output Report from the Reports palette of the e-SCOR 
toolbox and place it on the model detail.

2 Choose Setup Report as Enable Source Metrics, then configure the attributes 
to appear in the report according to the table above. 

For details, see Creating Input Reports for Configuring Key Parameters.

3 Create a Role Output Report, choose Setup Report as Asset Metrics, and 
configure the attributes to appear in the report according to the table.

4 Configure the Time Unit of each report to be Days. 

5 Choose Show Report on each report.

Tip For the Level 2 Output Report, hide all categories except the ES: Enable Source 
category.

6 Configure the Category Output Report to update once a week of simulation 
time, and configure the Role Output Report to update once every two weeks.

For details, see Generating Output Report Data.

7 Save the reports to the file named My-Tutorial-VMI-Summary-Reports.xls.

Asset Turns.average Value

Cash-to-Cash Cycle Time.average Value

Cash Flow.average Value

Report Attribute Name
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Configuring the Simulation to Run for a Fixed Duration
Configuring the Simulation to Run for a Fixed 
Duration

You will configure the central distributor model to run for three financial cycles, 
where each financial cycle is 2 weeks. To allow the model to reach a steady state, 
you will also configure the simulation to begin one week before the model 
outputs metrics to the reports. To ensure that the data for the last financial period 
is current in the output reports, you will configure the simulation to run for one 
day longer than the end of the last financial cycle. This means you will configure 
the simulation to run for 43 days, which is (3 x 14) + 1.

You will also configure the model to start generating orders after the delivery 
time of the first shipment. Because the central distributor delivers orders at 
8:00 AM each day, this means you should configure the starting time for 
generating orders to be some number greater than 8 hours, such as 9 hours. To do 
this, you configure order timing parameters for each Consumer role in the model.

To configure the simulation run for a fixed duration:

1 Display the properties dialog for the Scenario and on the Scenario tab, 
configure the Simulation Duration to be 43 days.

2 Click the Start Time tab and configure the start time of the simulation to be 
December 25, 2004, which is 7 days before January 1, 2005, the time at which 
the first report updates.

3 Display the properties dialog for the source product of each Consumer role 
and configure the Demand Detail parameters on the Demand tab, as follows:

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Parameter Value

Demand Start Time 9 hours

Demand Stop Time 43 days (6 weeks and 1 day)
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Summary: Central Distributor Case Study
To configure the central distributor case study model, you:

• Analyzed these features of the case study:

– The business problem, which is to determine optimal replenishment levels 
and to minimize inventory days of supply to guarantee 100% on-time 
performance, then to compare these results with a vendor-managed 
inventory system.

– The supply chain, which consists of single Base Manufacturer role, a 
central Distributor role, three site Distributor roles, and three Consumer 
roles.

– The input parameters, which relate to order quantity and frequency, 
planning, selling price, and delivery time.

– The output metrics, which relate to on-time performance, inventory days 
of supply, and other standard asset metrics.

• Configured the supply-chain by creating, connecting, and configuring roles, 
then assigning product specifications to each role in the model.

• Configured Level 2 SCOR by:

– Analyzing a diagram of key inputs and outputs.

– Mapping inputs and outputs for the Consumer roles.

– Mapping inputs and outputs for the Distributor roles.

– Mapping inputs for the Base Manufacturer role.

– Creating input reports for configuring key parameters.

– Configuring Level 2 SCOR parameters.

– Creating output reports for viewing key metrics.

– Configuring the simulation to run for a fixed duration.

You should now have a general understanding of the central distributor model 
case study and how to model it in e-SCOR. 

Next, you will estimate replenishment levels for the three distribution sites and 
run the simulation to determine performance over time.
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12
Running the Simulation:
Central Distributor Model
Describes how to run the central distributor model simulation by estimating 
initial replenishment levels.

Introduction 140

Estimating Initial Safety Stocks 140

Running the Simulation 141

Saving the Model 142

Summary: Running the Central Distributor Simulation 142
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Introduction
Before you can run the central distributor model simulation, you must configure 
the Safety Stock parameters for each of the Distributor roles in the model. The 
Safety Stock determines the level at which each distribution site, as well as the 
central distributor replaces its inventory. Each Distributor role uses the Safety 
Stock and the Minimum Reorder Quantity, along with the current number of 
products on order, to determine order size when performing its source planning. 

To avoid skewed metrics due to lack of initial inventory, you will also configure 
the Starting Inventory to be the same as the Safety Stock.

To run the central distributor model, you:

• Estimate initial safety stock to approximate the levels you think will achieve 
the desired results. 

• Run the simulation to determine whether the end consumers achieve 100% 
on-time performance.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-vmi.kb, which shows the finished 
model. To view the Excel report, open the file named Tutorial-VMI-Summary-
Reports.xls. Follow along in the existing model as you read through the 
exercises.

Estimating Initial Safety Stocks
Initially, you might estimate safety stocks for each of the three distribution sites 
by multiplying the average order size by the order frequency. You might add 
some extra to account for variation in order size, perhaps the amount required to 
accommodate the maximum order size. 

To estimate the safety stock of the central distributor, you might estimate the 
average demand of the three distribution sites. You would then determine the 
number of weeks of inventory that are required to keep on hand at all times to 
account for delivery times. It takes two weeks for the central distributor to receive 
shipment from the manufacturer, and it takes one week to deliver shipments to 
the distribution sites. Therefore, the central distributor needs to replenish its 
inventory at a level that is equal to three times the average weekly demand.

As outlined in the case study, the ranges of order sizes for each of the three 
consumers and the central distributor are:

• Consumer A: 50, 100, 150

• Consumer B: 100, 200, 400
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Running the Simulation
• Consumer C: 100, 100, 100

• Central Distributor: 250, 400, 650

For example, you might estimate the initial safety stocks for each of the three 
distribution sites and the central distributor as follows:

You will configure both the Safety Stock and the Initial Product Inventory Level 
of each product composite to use the estimated values. 

To configure replenishment and initial inventory levels:

1 Use the Product Composite Input Report to configure the Safety Stock 
parameter for each of the three distribution sites and the central distributor, 
according to the table above.

2 Configure the Starting Product Inventory Level to be the same as the 
Safety Stock.

Running the Simulation
You will now run the simulation to determine whether each consumer achieves a 
100% on-time performance, given your initial estimates. You will also look at 
inventory days of supply and the other asset metrics. 

The model runs different processes at different phases of the simulation.

To run the simulation, using estimated safety stocks:

1 Run the simulation in jump mode.

For details, see Running the Simulation.

2 Display the Category Output Report so you can view the Supplier On-Time 
Performance metric as the model runs.

As the model runs, buyer roles place orders and supplier roles deliver 
shipments. At the same time, the model computes Supplier On-Time 
Performance. 

3 Display the Role Output Report to view the Inventory Days of Supply and 
other asset metrics as the model runs.

Role Initial Safety Stock Estimate Value

Site A 100 units x 7 days + 50 = 750

Site B 200 units x 7 days + 200 = 1600

Site C 100 units x 7 days = 700

Central Distributor 3 (7 days x (100 + 200 + 100)) = 8400
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Each financial period, which is 2 weeks, each role computes incoming and 
outgoing financial metrics, days of supply, and other asset metrics, based on 
the Net Selling Price of each delivery product in the model. 

4 Observe the metrics in the Metrics toolbar and in the reports until the 
simulation stops.

The simulation runs for 43 days, then stops when the simulation clock reads 
February 6.

Did your safety stock estimates result in 100% on-time performance? No, neither 
the three consumers nor the distribution sites had anywhere close to 100% 
Supplier On-Time Performance. 

Now, let’s look at inventory days of supply and assets. 

In this simulation, the distribution sites are carrying less than one day of 
inventory, which is way too low. The sites take between 0 and 168 days to turn 
over their inventory. Two of the three sites spend more money than they take in, 
based on a positive cash-to-cash cycle time. Therefore, the asset metrics for the 
three distribution sites, as well as for the central distributor, are not very 
favorable, because the amount of inventory is not sufficient to supply all sites 
equally well, based on demand.

To increase on-time performance and balance asset metrics between the sites, you 
need to increase safety stocks, which you will experiment with later in this 
tutorial.

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Summary: Running the Central Distributor 
Simulation

To run the central distributor simulation, you:

• Estimated initial safety stock, based on order size and order frequency.

• Ran the simulation and view the on-time performance and days of supply.

You should now have a better understanding of how safety stocks, order size, and 
order frequency affect on-time performance.
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Optimizing the
Central Distributor Model
Describes how to determine optimal replenishment levels for the central 
distributor model and how to implement a vendor-managed inventory system.

Introduction 144

Determining Optimal Safety Stocks 144

Implementing a Vendor-Managed Inventory Control System 148

Saving the Model 149

Summary: Optimizing the Central Distributor Model 150
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Introduction
Based on the results you obtained by using estimates, you will now fine-tune the 
estimates to optimize the central distributor model. To optimize the model, you:

• Determine optimal safety stocks. 

The goal is to achieve 100% on-time performance, given the lowest possible 
safety stocks and the lowest inventory carrying costs, measured in Inventory 
Days of Supply. To do this, first, you will optimize safety stocks by 
configuring the model for the worst case scenario, then you will attempt to 
minimize inventory days of supply, given normal demand and delivery 
times. You will find that the safety stocks need to be significantly higher than 
you originally estimated to account for variation in order size and delivery 
times.

• Implement a vendor-managed inventory control system in which the central 
distributor owns and controls all the inventory—its own, as well as that of 
each of its distribution sites. 

By implementing a vendor-managed inventory control system, the central 
distributor believes it can make deliveries more frequently, which means it 
can carry less inventory centrally. You will find that the central distributor 
does not need to carry that much more inventory than it does when it owned 
only its own inventory. Therefore, the decrease in inventory levels required 
due to more frequent deliveries to some extent offsets the increase in 
inventory levels required for each of the distribution sites.

Shortcut If you do not have time to work through the exercises in this part of the tutorial, in 
e-SCOR, open the file named escor-tutorial-vmi.kb, which shows the finished 
model. To view the Excel report, open the file named Tutorial-VMI-Summary-
Reports.csvxls. Follow along in the existing model as you read through the 
exercises.

Determining Optimal Safety Stocks
One way of determining optimal safety stocks is to configure the model for the 
worst case scenario, as follows:

• Configure each customer to use the maximum order size, in all cases.

• Configure the central distributor to take the maximum number of days to 
deliver its shipments, in all cases.

When you run the simulation, you can then experiment with larger and larger 
safety stocks for each of the three distribution sites until you achieve close to 100% 
Supplier On-Time Performance. When you set the order sizes and delivery times 
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Determining Optimal Safety Stocks
back to the original minimum, mode, and maximum settings, the safety stocks 
should generally be sufficient to cover the worst case.

Once you have optimized safety stocks for the worst case scenario, you can then 
experiment with minimizing the inventory days of supply, given normal 
customer demand and delivery times.

Optimizing Safety Stocks for the Worst Case 
Scenario

First, you will optimize safety stocks by simulating the worst case scenario.

To optimize safety stocks for the worst case scenario:

1 In Excel, open the file named Tutorial-VMI-Summary-Reports.xls located in 
the kbs directory.

Tip Remember, you can open this report from the Start menu.

2 Configure the Demand Order Size Minimum, Mode, and Maximum to be the 
maximum value for each of the three Consumer roles, as follows:

3 As a starting point, increase the initial estimate for the Safety Stock for each of 
the three distribution sites by the amount of the maximum order size, as 
follows:

4 Configure the Transportation Duration Min to be the same as the Delivery 
Time Max, as follows:

Consumer Site A Site B Site C

Demand Order Size Min 150 400 100

Demand Order Size Mode 150 400 100

Demand Order Size Max 150 400 100

Sites A B C

Safety Stock 900
(750 + 150)

2000
(1600 + 400)

800
(700 + 100)

Distributor

Transportation Duration Mini 9

Transportation Duration Max 9
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5 Run the simulation until it stops.

Is the increase in safety stock enough to compensate for the worst case 
scenario in terms of order size and deliver times? No, the on-time 
performance is still nowhere near 100% for the three consumers.

6 Continue increasing the safety stocks and running the simulation until you 
obtain a 90% or greater on-time performance for each of the three consumers.

For example, you might experiment with the following sets of values for 
safety stock for the three distribution sites and the central distributor until you 
obtain close to 100% on-time performance: 

You should achieve approximately 90% or greater on-time performance for all 
three consumers with safety stocks approximately equal to those listed in the 
last row of the table above. At the same time, the inventory days of supply for 
each of the three distributors should be relatively low. 

7 Set the Transportation Duration Min back to its original value, which is 
6 days.

8 Set the Demand Order Size Min, Mode, and Max to their original values, 
as follows:

9 Run the simulation again to determine inventory days of supply, given 
normal order sizes and delivery times.

The sites should each have 100% on-time performance and the inventory days of 
supply should be somewhat higher than in the worst case scenario.

Site A Site B Site C
Central
Distributor

Safety Stock (900) (2000) (800) (8400)

1800 4000 1200 8600

2000 5000 1400 8800

2200 6000 1600 9000

2200 6500 1600 9000

Consumer A B C

Demand Order Size Min 50 100 100

Demand Order Size Mode 100 200 100

Demand Order Size Max 150 400 100
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Determining Optimal Safety Stocks
Minimizing Inventory Days of Supply

Now, let’s see if you can minimize inventory carrying costs by reducing the 
inventory days of supply, while still maintaining 100% on-time performance.

To minimize inventory days of supply:

 Experiment with reducing the safety stocks for each of the three sites and the 
central distributor, while still maintaining 100% on-time performance, with 
the goal of minimizing the inventory days of supply as much as possible.

Once you think you have settled on safety stock values, run the simulation again 
with the same numbers to verify that on-time performance remains at 100%. If the 
on-time performance becomes less than 100%, increase the safety stock again. 

For example, you might experiment with the following sets of values for safety 
stock for the three distribution sites and the central distributor:

Note The numbers you try might be different because of variation in order size and 
delivery times.

In the end, you should achieve approximately 100% on-time performance and 
inventory days of supply equal to approximately 10 or below for each of the three 
sites.

As you have demonstrated, to guarantee 100% on-time performance, you must 
set the safety stocks to significantly higher values than originally estimated. The 
reason is that each distribution site must build up enough initial inventory so it 
does not run out before it receives its first shipment. Therefore, the optimal safety 
stock is a function of these factors:

• Variation in order size.

• Variation in order frequency.

Site A Site B Site C
Central
Distributor

Safety Stock (2200) (6500) (1600) (9000)

2100 5000 1400 8500

2000 4000 1500 8400

2100 4200 1600 8300

2100 4500 1600 8400
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• Variation in delivery time.

• Initial shipment delay time.

Implementing a Vendor-Managed Inventory 
Control System

As the case study’s business problem presented, the central distributor believes it 
can reduce delivery time by half by implementing a vendor-managed inventory 
control system. The question you need to answer is: what effect will this have on 
overall assets for the central distributor?

To simulate a vendor-managed inventory control system, configure the delivery 
times to be half what they currently are, then experiment with lower safety stocks 
until you obtain 100% on-time performance with minimum inventory days of 
supply. In a vendor-managed inventory control system, the days of supply is the 
sum of the days of supply for each of the three distribution sites, plus the days of 
supply for the central distributor.

To implement a vendor-managed inventory control system:

1 Configure the delivery times, as follows:

2 Run the simulation, using the optimized safety stocks, as follows:

3 Now, optimize the safety stocks until you achieve the lowest inventory days 
of supply while maintaining 100% on-time performance.

In a vendor-managed inventory scenario, the safety stocks should be somewhat 
lower for all three distribution sites and for the central distributor.

To answer the question about the effect a vendor-managed inventory control 
system has on assets, compare the sum of the total inventory costs for all three 
distribution sites and the central distributor in the optimized scenario with the 

Distributor

Transportation Duration Min 3

Transportation Duration Max 5

Site A Site B Site C
Central
Distributor

Safety Stock 2100 4500 1600 8400
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Saving the Model
same sum in the vendor-managed inventory scenario. For example, in two sample 
simulations, the results might be as follows:

As you can see, Sites A and B have significantly lower inventory carrying costs, 
and Site C has somewhat lower same carrying costs. This decrease is due to the 
fact that the Central Distributor is now carrying the inventory for the distribution 
sites. Site C has more or less the same carrying costs because the end consumer 
has no variation in demand, so it must carry the same amount of inventory.

The central distributor also has a lower inventory carrying cost in the vendor-
managed inventory scenario than in the optimized scenario. To determine this 
difference, compare the central distributor’s carrying costs in the optimized 
scenario ($29.8) with the sum of the carrying costs of the central distributor plus 
each distribution site in the vendor-managed inventory scenario ($26.4). As you 
can see, the central distributor’s carrying costs are approximately the same for the 
vendor-managed inventory scenario as they are for the optimized scenario. 
Furthermore, in the vendor-managed inventory scenario, the overall inventory 
carrying costs in the vendor-managed inventory scenario ($26.4) are less than half 
of what they are in the optimized scenario ($70.1).

The decreased carrying costs are due to the fact that delivery times are shorter 
and order frequency is greater, which means the central distributor can carry less 
inventory. Overall, the vendor-managed inventory system is a much more cost-
effective inventory control system.

Saving the Model
Save the model to your project name.

For details, see Saving a Model.

Role
Optimized 
Scenario

Vendor-Managed 
Inventory Scenario

Site A $11.9 $5.6

Site B $21.2 $8.1

Site C $7.3 $6.2

Central Distributor $29.8 $6.5

Total $70.2 $26.4
147



Summary: Optimizing the Central Distributor 
Model

To optimize the central distributor model, you:

• Determined optimal safety stocks for each distribution site by:

– Optimizing safety stocks for the worst case scenario, which involves 
setting order size and delivery times to their maximum values in all cases, 
then increasing safety stocks to obtain at least a 90% on-time performance.

– Minimizing inventory days of supply, which involves setting order size 
and delivery times back to their original levels, then reducing safety stocks 
to minimize inventory days of supply while maintaining 100% on-time 
performance.

• Implemented a vendor-managed inventory control system by reducing 
delivery times and corresponding safety stocks, then comparing the total 
inventory days of supply for the central distributor and the three distribution 
sites with that of the optimized simulation where each site owns its own 
inventory.

This table provides a summary of the parameters you configure for each scenario 
described in these tutorials for the VMI model:

Parameters Estimate Worst Case Optimized
Vendor-

Managed 
Inventory

Safety Stock

Site A 750 2200 2100 1500

Site B 1600 6500 4500 3500

Site C 700 1600 1600 1400

Central 
Distributor 8400 9000 8400 6300

Transportation 
Duration
(Central 
Distributor)

Min 7 9 7 3

Max 9 9 9 5
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Summary: Optimizing the Central Distributor Model
You should now understand some of the strategies you can use to improve 
on-time performance and minimize carrying costs. You should also understand 
the impact on carrying costs of implementing a vendor-managed inventory 
control system. Finally, you should be able to make key business decisions, based 
on opportunity costs associated with providing different service levels for 
different customers in the supply chain.

Congratulations! You have finished the e-SCOR tutorials.

Planning Period
(Sites and Central 
Distributor)

Min 7 7 7 4

Max 7 7 7 4

Parameters Estimate Worst Case Optimized
Vendor-

Managed 
Inventory
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